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ΕΘΝΙΚΟ ΜΕΤΣΟΒΙΟ ΠΟΛΥΤΕΧΝΕΙΟ 

ΣΧΟΛΗ ΠΟΛΙΤΙΚΩΝ ΜΗΧΑΝΙΚΩΝ 

ΕΡΓΑΣΤΗΡΙΟ ΜΕΤΑΛΛΙΚΩΝ ΚΑΤΑΣΚΕΥΩΝ 

 

ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ 

ΕΜΚ ΔΕ 2013/45 

Σεισμική συμπεριφορά αρχαίων κιόνων με αριθμητικές μεθόδους 

 
Κορόζης Η. Α (Επιβλέπων: Ραυτογιάννης I.) 

Περίληψη 

Ο σκοπός της παρούσας διπλωματικής εργασίας είναι η μοντελοποίηση και διερεύνηση 

της σεισμικής συμπεριφοράς δύο αρχαίων μαρμάρινων σπονδυλωτών κιόνων 

συνδεόμενων στη κορυφή τους με επιστύλιο, με τη χρήση του προγράμματος Abaqus. 

Πραγματοποιήθηκε δυναμική ανάλυση του μοντέλου με τη χρήση τριών διαφορετικών  

συναρτήσεων απόσβεσης μισού ημιτονοειδούς παλμού για την επιτάχυνση. Στο τέλος της 

εργασίας παρουσιάζονται τα αποτελέσματα αναλυτικά και γραφικά και εξάγονται τα 

συμπεράσματα της έρευνας. 

 

Στο 1ο κεφάλαιο παρουσιάζονται γενικές πληροφορίες σχετικά με τους αρχαίους 

ναούς, τα μέρη από τα οποία αποτελούνται καθώς και κύρια χαρακτηριστικά των μερών 

αυτών. 

 

Στο 2
ο
 κεφάλαιο περιγράφεται η σεισμική συμπεριφορά των πολύ-σπόνδυλων κιόνων 

βασιζόμενη σε συμπεράσματα παλαιότερων μελετών και αναλύονται οι κύριοι παράγοντες  

επιρροής της κίνησης. 

 

Στο 3
ο
 κεφάλαιο γίνεται αναφορά στη γεωμετρία του φορέα, στο υλικό και στις 

ιδιότητες του. Ακόμα, γίνεται αναλυτική περιγραφή της συνάρτησης απόσβεσης μισού 

ημιτονοειδούς παλμού για την επιτάχυνση και των τιμών για τις τρεις περιπτώσεις  που 

χρησιμοποιήθηκαν. 

 

Στο 4
ο
 κεφάλαιο παρατίθεται η διαδικασία της μοντελοποίησης με τη μέθοδο των 

πεπερασμένων στοιχείων και η εισαγωγή των δεδομένων στο πρόγραμμα Abaqus. 

Δίδονται αναλυτικά τα βήματα που ακολουθήθηκαν για την εισαγωγή της γεωμετρίας του 

φορέα, τον καθορισμό του υλικού, την εφαρμογή των αλληλεπιδράσεων, τη δημιουργία 

της συνδεσμολογίας,  την επιβολή των συνοριακών συνθηκών, την εφαρμογή των φορτίων 

και τη δημιουργία του πλέγματος. 

 

Στο 5
ο
 κεφάλαιο περιγράφονται τα αποτελέσματα της δυναμικής ανάλυσης του 

μοντέλου για τις τρεις διαφορετικές περιπτώσεις επιτάχυνσης. 

 

Στο 6
ο
 κεφάλαιο παρουσιάζονται τα συμπεράσματα της εργασίας. 
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Abstract 

The main purpose of this thesis is the modeling and study of the seismic behavior of 

two ancient marble columns, consisting of blocks and connected with architrave in the top, 

with the aid of Abaqus 6.10 CAE software. A dynamic analysis is conducted using three 

different functions of damped half sine-wave pulse for acceleration. The results are 

presented both analytically and graphically and conclusions are drawn. 

 

In Chapter 1, general information is provided about the ancient temples, their 

consisting parts, and their main characteristics. 

 

In Chapter 2, the seismic behavior of multi-spondylon columns is described -based on 

conclusions of previous studies- and the main influencing factors of movement are 

analyzed. 

 

In Chapter 3, the geometry of the structure and the material properties are presented. 

Moreover, the function of the damped half sine-wave pulse for acceleration is described 

and the analytical values for the three cases used are provided.  

 

Chapter 4 describes the modeling process -using the finite element method- and the 

data entry procedure in the program Abaqus. The steps followed about entering geometry 

and material data for the structure, applying interactions, creating assembly, imposing loads 

and boundary conditions as well as creating the mesh are detailed. 

 

 In Chapter 5, the results of the dynamic analysis of the model for the three different 

cases of acceleration are described. 

 

In Chapter 6, the conclusions of the study are drawn. 
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Κεφάλαιο 1ο - Τα αρχαία μνημεία και τα χαρακτηριστικά 

τους 

1.1 Εισαγωγή 

Σε αυτό το κεφάλαιο γίνεται μία εισαγωγή που αφορά τα αρχαία μνημεία. 

Περιγράφονται τα μέρη από τα οποία αποτελείται ένα αρχαίο μνημείο, η χρησιμότητα 

ορισμένων απ’ αυτά, τα βασικά χαρακτηριστικά τους και τα υλικά που συνηθίζονταν να 

χρησιμοποιούνται. 

1.2 Γενικά περί αρχαίων μνημείων 

Τις τελευταίες δεκαετίες παρατηρήθηκε έντονο ενδιαφέρον για την αποκατάσταση και 

τη συντήρηση των αρχαίων μνημείων, τα οποία είχαν υποστεί ζημιές είτε λόγω 

περιβαλλοντικών παραγόντων, όπως είναι οι σεισμοί, οι πλημμύρες και οι πυρκαγιές είτε 

λόγω ανθρώπινης παρέμβασης, όπως  είναι για παράδειγμα ο βομβαρδισμός του 

Παρθενώνα το 1688. Κάποια από τα αρχαία μνημεία βρίσκονται σε περιοχές έντονης 

σεισμικής δραστηριότητας, όπως είναι η Ελλάδα, η Μικρά Ασία και η Κύπρος.  

Michaltsos and Raftoyiannis [10] 

 

1.2.1 Υλικό και μέρη που αποτελούν ένα αρχαίο μνημείο 

Τα  πρώτα αρχαία μνημεία ήταν από ξύλο, ενώ αργότερα κατασκευάζονταν από 

μάρμαρο και σήμερα όσα έχουν διασωθεί είναι κατασκευασμένα από μάρμαρο. Από αυτά 

τα αρχαία μνημεία που έχουν διασωθεί, παρατηρείται ότι αποτελούνται από πολύ-

σπόνδυλους κίονες που, είτε συνδέονται  μεταξύ τους  με επιστύλια στις κορυφές τους, 

είτε  μεταφέρουν ελεύθερα στεκούμενα αγάλματα στις κορυφές τους. 

Kounadis (2011) [19] 
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Εικόνα 1.2.1.1: Χαρακτηριστικά παραδείγματα αρχαίων ναών. Από πάνω προς τα κάτω 

διακρίνονται οι ναοί στο Σούνιο, στην Αίγινα και στις Βάσσες Μεσσηνίας. 
 

Τα μέρη από τα οποία αποτελείται η όψη ενός αρχαίου ναού είναι: ο κίονας με το 

κιονόκρανο, η κρηπίδα, ο στυλοβάτης και τέλος ο θριγκός. 

•Η κρηπίδα είναι το λίθινο βαθμιδωτό βάθρο πάνω στο οποίο γίνεται η θεμελίωση του 

ναού και στηρίζονται οι κίονες και συνήθως αποτελείται από 3 βαθμίδες.  

•Ο στυλοβάτης αποτελεί  την τελευταία βαθμίδα αυτού του βάθρου που σχηματίζει το 

δάπεδο του ναού και το θεμέλιο.  

•Οι κίονες αποτελούνται από μεμονωμένους λίθους, τους σπονδύλους και το κιονόκρανο. 

Η διάμετρος των σπονδύλων μειώνεται προς τα πάνω. Επίσης οι ενώσεις των σπονδύλων 

δεν ήταν ορατές μετά το πέρας των εργασιών καθώς καλύπτονταν με ελαφρό επίχρισμα.  
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Εικόνα 1.2.1.2: Μεμονωμένοι σπόνδυλοι διαφορετικού ύψους και διαφορετικής 

διαμέτρου. 
 

Χαρακτηριστικό των κιόνων είναι η ένταση, δηλαδή ένα ανεπαίσθητο «φούσκωμα» 

στο μεσαίο τμήμα των κιόνων. Στην κλασική περίοδο η μέγιστη τιμή της έντασης 

διαπιστώνεται στα 2/5 του ύψους του κίονα. Η ένταση δεν είναι σε καμιά περίπτωση 

μεγαλύτερη από τη διάμετρο της βάσης του κίονα και είναι σημαντικό χαρακτηριστικό 

των κιόνων, καθώς, όπως έχει αποδειχθεί σε παλαιότερα πειράματα, υπάρχει 

διαφοροποίηση στη δυναμική συμπεριφορά κιόνων που έχουν ένταση σε σχέση με κίονες 

που δεν έχουν. Επίσης, χαρακτηριστικό των κιόνων είναι η μείωση, δηλαδή ο κίονας 

καθώς ανεβαίνει γίνεται όλο και λεπτότερος. Ακόμη, σημαντικό στοιχείο των κιόνων είναι 

η κλίση προς το κύριο μέρος του ναού, δηλαδή οι κίονες δεν είναι κατακόρυφοι.   

Επίσης, οι κίονες αποτελούνται από ραβδώσεις που καταλήγουν είτε σε καμπύλες είτε 

σε ακμές ανάλογα με το ρυθμό που ακολουθήθηκε.  Ο αριθμός των ραβδώσεων ποικίλει 

από 16 έως 20. Το βάθος των ραβδώσεων μπορεί να διαφέρει και έτσι άλλοτε οι 

ραβδώσεις είναι βαθύτερες στο πάνω μέρος του κίονα, άλλοτε είναι βαθύτερες στο κάτω 

μέρος και άλλοτε το βάθος παραμένει ίδιο. 

Στο τέλος του κίονα, στο σημείο που ενώνεται με το κιονόκρανο υπάρχουν οι 

δακτύλιοι εγκοπής, τρεις ή τέσσερις. 

 

•Το κιονόκρανο είναι το μέρος που καταλήγει ο κίονας. Στον δωρικό ρυθμό αποτελείται 

από τον έχινο και τον άβακα, ενώ στον ιωνικό από τις έλικες και τον άβακα. 

•Θριγκός είναι ολόκληρη η ανωδομή πάνω από τα κιονόκρανα και αναλύεται σε 

λεπτομερέστερα μέρη, όπως είναι η ζωοφόρος, οι μετόπες και τα τρίγλυφα και τα 

επιστύλια. 

•Τα επιστύλια είναι παραλληλόγραμμα κομμάτια μαρμάρου που συνδέουν τους κίονες και 

λέγονται έτσι, επειδή βρίσκονται επί των στύλων. Ανάλογα με το μέγεθος του μνημείου 

μπορεί να είναι ολόσωμα ή και να αποτελούνται από δύο και τρία στοιχεία. Στα μικρότερα 

μνημεία το επιστύλιο είναι ολόσωμο, δηλαδή αποτελείται από ένα συμπαγές κομμάτι 

μαρμάρου. Σε μεγαλύτερα μνημεία αποτελείται από δύο στοιχεία ή ακόμη και τρία, όπως 

στον Παρθενώνα. Συχνά τα επιστύλια συνδέονται μεταξύ τους με συνδέσμους. Τέλος, τα 

επιστύλια παρουσιάζουν την ίδια καμπύλωση με την κρηπίδα. 

Οι κίονες που συνδέονταν με επιστύλια και τοποθετούνταν σε σειρά μέσα και γύρω 

από τα οικοδομήματα της αρχαιότητας αποτελούσαν την κιονοστοιχία. Οι κιονοστοιχίες 

χρησίμευαν στο σχηματισμό στοών, στην υποστήριξη στεγών καθώς και στη διαίρεση 

ενός οικοδομήματος σε κλίτη. Σχηματίζονταν με βάση τον αριθμό των κιόνων, της μεταξύ 

τους απόστασης και το ρυθμό αυτών. Σε αρκετά πειράματα που διεξήχθησαν φάνηκε ότι οι 

κιονοστοιχίες είναι πιο σταθερές από τους ανεξάρτητους κίονες και δεν χαρακτηρίζονται 
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από την έντονη μη-γραμμική συμπεριφορά των μεμονωμένων πολύ-σπόνδυλων κιόνων 

που θα αναφερθεί παρακάτω. 

 
                                             Εικόνα 1.2.1.3: Ένα επιστύλιο δύο κιόνων. 

 

Στο δωρικό ρυθμό μετά τα επιστύλια έχουμε τα τρίγλυφα και τις μετόπες, ενώ στον 

ιωνικό ρυθμό έχουμε την ζωοφόρο. Τρίγλυφο είναι μια ορθογώνια πλάκα μαρμάρου, η 

οποία έχει 3 κατακόρυφες γλυφές, δύο ολόκληρες και δύο ημιγλυφές δεξιά και 

αριστερά. Μετόπη είναι μια ορθογώνια πλάκα μαρμάρου, η οποία μπορεί να έχει 

ανάγλυφη ή γραπτή διακόσμηση. Στο τμήμα που βρίσκεται ανάμεσα σε δύο κίονες 

αντιστοιχούν 2 μετόπες και 3 τρίγλυφα. Η ζωοφόρος είναι μια ζώνη από ανάγλυφες 

πλάκες. 

 

Εικόνα 1.2.1.4: Βασικά στοιχεία της ανωδομής ενός αρχαίου ναού. Στα αριστερά ο ναός είναι 

ιωνικού ρυθμού και στα δεξιά δωρικού ρυθμού. 
 

Δασίου, Ψυχάρης, Βάγιας (2008) [4] 

Δασίου,  Μουζάκης, Ψυχάρης, Παπαντωνόπουλος, Βάγιας (2008) [5] 

Αρχαϊκή Αρχιτεκτονική [1] 



10 

Κεφάλαιο 2ο - Η σεισμική συμπεριφορά των πολύ-

σπόνδυλων κιόνων 

2.1 Εισαγωγή 

Είναι αναγνωρισμένο από πολλές παλαιότερες μελέτες ότι οι πολύ-σπόνδυλοι κίονες 

παρουσιάζουν πάρα πολύ καλή συμπεριφορά απέναντι στη σεισμική δραστηριότητα. Κατά 

τη διάρκεια ενός σεισμού στα αρχαία μνημεία δημιουργείται ένα σύστημα απορρόφησης 

ενέργειας διαφορετικό από αυτό των σύγχρονων κατασκευών. Συγκεκριμένα, η 

απορρόφηση της σεισμικής ενέργειας πραγματοποιείται μέσα από την ολίσθηση και τον 

λικνισμό των λίθων, είτε ανεξάρτητα, είτε και σε ομάδες. 

 

 
 

Εικόνα 2.1.1: Λικνισμός και ολίσθηση των σπονδύλων ενός ανεξάρτητου κίονα. 

 

Δασίου, Ψυχάρης, Βάγιας [4] 

2.2 Παραδοχές παλαιότερων μελετών 

Η σταθερότητα των σπονδύλων έναντι ολίσθησης και λικνισμού υπό την επίδραση 

ισχυρής εδαφικής κίνησης είναι ένα πολύ ενδιαφέρον πρόβλημα, το οποίο απασχόλησε 

αρκετούς ερευνητές τις τελευταίες δεκαετίες.   

Παρότι το προαναφερθέν πρόβλημα μοιάζει απλό, είναι αρκετά δύσκολο να 

αντιμετωπιστεί αναλυτικά , λόγω της μη-γραμμικής φύσης του. Η μη γραμμική φύση του 

προβλήματος  προκύπτει πρώτον, διότι οι εξισώσεις κίνησης αλλάζουν, όταν η γωνία 

περιστροφής αλλάζει πρόσημο και δεύτερον, επειδή τη στιγμή που αλλάζει πρόσημο η 

γωνία συμβαίνει μια κρούση. Λόγω της μη γραμμικής φύσης του προβλήματος σε 

παλαιότερες μελέτες γίνονται διάφορες παραδοχές, οι οποίες έχουν μικρή επίδραση στο 

τελικό αποτέλεσμα. 
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•Μία παραδοχή που γίνεται είναι η προσομοίωση των τραπεζοειδών block σε ορθογωνικά. 

Θεωρώντας το λόγο 
1

2

b

b
k   ( Εικόνα 2.2.1), o οποίος εκφράζει την αλλαγή του πλάτους 

καθ’ ύψος του block και γνωρίζοντας ότι στους αρχαίους κίονες ο λόγος αυτός κυμαίνεται 

μεταξύ 0.95 και 1.00, αποδεικνύεται ότι υπάρχει ισοδύναμο ορθογωνικό block με 

2

1
1

k
bb . 

 
 

 

 

 

 

 

 

 

 

Εικόνα 2.2.1: Τραπεζοειδή block και το ισοδύναμο ορθογωνικό. 

 

Έτσι μπορούν να μελετηθούν ισοδύναμα συστήματα ορθογωνικών block αντί των 

κανονικών. Η προσομοίωση αυτή αφορά κυρίως τη ροπή αδράνειας J g  που υπεισέρχεται 

στις εξισώσεις κίνησης. 

• Άλλος ένας παράγοντας που επηρεάζει τη μελέτη ενός παρόμοιου μοντέλου είναι η 

παράλειψη της επιρροής των πόλων που είναι τοποθετημένοι μεταξύ 2 σπονδύλων.  

• Τέλος, η τρίτη παραδοχή αφορά την κάθετη συνιστώσα της σεισμικής δράσης, η οποία 

παραλείπεται. Ακόμα και όταν πολλοί ερευνητές την συμπεριλαμβάνουν στις εξισώσεις 

κίνησης, ούτε τις επιλύουν ούτε μελετούν την επιρροή αυτής της συνιστώσας. 

Michaltsos and Raftoyiannis [10] 

2.3 Παράγοντες επιρροής της κίνησης 

2.3.1 Γενικά 

Η δυναμική συμπεριφορά ενός συστήματος από blocks εξαρτάται από ορισμένους 

παράγοντες που επηρεάζουν την κίνηση. Τέτοιοι παράγοντες είναι:  

• Η απόσταση επιρροής ενός σεισμού 

• Η κρούση που πραγματοποιείται 

• Η γωνία περιστροφής και η γωνιακή ταχύτητα 

• Η συνάρτηση πλάτους της επιτάχυνσης και ειδικότερα το μέγιστο πλάτος και η διάρκεια 

του 

• Η απόσβεση του σεισμού 

2.3.2 Η απόσταση επιρροής ενός σεισμού 

Η εδαφική κίνηση μπορεί να οφείλεται σε σεισμό, είτε κοντινού επίκεντρου (L≤70km),  

είτε μακρινού (L>70km). Και στις δύο περιπτώσεις, η εδαφική κίνηση είναι συνάρτηση 

του χρόνου t. Από την έκφραση της κίνησης ως συνάρτησης του χρόνου συνεπάγονται οι 

συναρτήσεις για την ταχύτητα και την εδαφική επιτάχυνση. 

 

 

h 

1 2b b
b

2
 

b2= k b1  

b1 

(a)                               (b)   
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                                                                  (1) 

Είναι γνωστό ότι, τόσο οι εδαφικές κινήσεις, όσο και οι εδαφικές ταχύτητες και 

επιταχύνσεις, όσο απομακρυνόμαστε από την εστία του σεισμού, μειώνονται. Αυτό 

συμβαίνει λόγω γεωμετρίας και λόγω της απόσβεσης του σεισμού. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 2.3.2.1: Το επίκεντρο και η εστία του σεισμού. [15] 

 

Έχει αποδειχτεί ότι οι κάθετες συνιστώσες της σεισμικής δράσης πρακτικά 

εξαφανίζονται για HL , δηλαδή για αποστάσεις από το επίκεντρο μεγαλύτερες ή ίσες 

από το εστιακό βάθος. 

Michaltsos and Raftoyiannis [10] 

2.3.3 Το πρόβλημα της κρούσης 

Ένα block που υποβάλλεται σε οριζόντια εδαφική κίνηση ενδέχεται να ανατραπεί  ή να 

μην ανατραπεί.  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 2.3.3.1: Σπονδυλωτός κίονας που έχει ανατραπεί. 
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impact  

Στην περίπτωση που δεν ανατραπεί, θα ταλαντευτεί γύρω από το σημείο Ο, θα επιστρέψει 

πίσω και μετά την κρούση θα περιστραφεί γύρω από το σημείο Ο’. 

   

 
 

 

 

 

 

 

 

Εικόνα 2.3.3.2: Κρούση ενός στερεού block  εξαιτίας του λικνισμού. 

 

Η κλασσική θεωρία της κρούσης λέει: 

 

21

b11b212
a2
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b22b121
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II
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

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

                                                                                             (2) 

 

Για την περίπτωση ενός περιστρεφόμενου σώματος το οποίο εδράζεται στο έδαφος  

έχουμε ba 11  και 1   και μετά ε=
b

a

2

2




. 

Το φαινόμενο της κρούσης που παρουσιάζεται στην εικόνα έχει το επιπλέον 

χαρακτηριστικό ότι πριν την κρούση το block περιστρέφεται γύρω από το Ο, ενώ μετά την 

κρούση γύρω από το Ο’, δηλαδή έχουμε μία αλλαγή του κέντρου περιστροφής. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 2.3.3.3: Block κολώνας περιστρέφεται γύρω από τα σημεία Ο και Ο’ πριν και μετά την 

κρούση. 

 

Έχει αποδειχτεί σε προηγούμενες μελέτες ότι ο συντελεστής αποκατάστασης ε είναι ένας 

πολύ σημαντικός παράγοντας και ότι ακόμα και μία μικρή μεταβολή στην τιμή του μπορεί 

να επηρεάσει μια ασταθή κίνηση σε σταθερή. Μεγάλες τιμές του ε οδηγούν σε ασταθή 

κίνηση ενώ μικρές τιμές οδηγούν σε σταθερή κίνηση. 

Michaltsos and Raftoyiannis [10] 
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2.3.4 Η γωνία περιστροφής και η γωνιακή ταχύτητα 

Ανάλογα με το πρόσημο της αρχικής γωνίας περιστροφής και της αρχικής γωνιακής 

ταχύτητας το άκαμπτο block μπορεί να σταθεροποιηθεί ή να αποσταθεροποιηθεί. 

Ειδικότερα, υποθέτοντας ότι 0 , η μείωση τιμών των θετικών γωνιών  ή η αύξηση 

τιμών των αρνητικών γωνιών  τείνουν να σταθεροποιήσουν το block αποτρέποντας την 

ανατροπή. Επίσης, για 0 , η μείωση τιμών των θετικών αρχικών γωνιακών ταχυτήτων 

  ή η αύξηση τιμών των αρνητικών αρχικών γωνιακών ταχυτήτων τείνουν να 

σταθεροποιήσουν το block έναντι ανατροπής. 

Ακόμη, θετικές τιμές των  και    έχουν επιβλαβή αποτέλεσμα στη σταθερότητα 

του άκαμπτου block, ενώ αρνητικές τιμές των  και    έχουν  ευεργετικό αποτέλεσμα 

στη σταθερότητα του άκαμπτου block. Όταν  και    έχουν διαφορετικά πρόσημα, το 

αποτέλεσμα τους είναι ενδιάμεσο συγκρινόμενο με το αποτέλεσμα, όταν έχουν ίδιο 

πρόσημο. 

Kounadis (2012) [18] 

2.3.5 Η συνάρτηση πλάτους της επιτάχυνσης  

Στο συγκεκριμένο πρόβλημα υπάρχουν δύο είδη προϋποθέσεων, οι στατικές και οι 

δυναμικές προϋποθέσεις. Ως στατικές προϋποθέσεις εννοούνται εκείνες που είναι 

απαραίτητες ώστε να σηκωθεί το block. Ως δυναμικές  προϋποθέσεις εννοούνται εκείνες 

που είναι απαραίτητες, ώστε το block να ανατραπεί χωρίς ολίσθηση. Το θεμελιώδες 

πρόβλημα στη δυναμική αυτών των συνδεσμολογιών άκαμπτων σωμάτων είναι η μελέτη  

του λικνισμού ενός άκαμπτου block υπό την επίδραση της εδαφικής κίνησης, η οποία 

ενδέχεται να οδηγήσει σε ανατροπή. 

 

•Δυναμικές προϋποθέσεις 

Όταν το block αρχίζει να κινείται η ανατροπή του εξαρτάται, όχι μόνο από το  μέγεθος 

της επιτάχυνσης, αλλά και από τη διάρκεια του μεγέθους αυτού. Εξισώσεις που έχουν 

αποδειχτεί σε παλαιότερες μελέτες δείχνουν ότι το πλάτος της επιτάχυνσης που απαιτείται 

για την ανατροπή του block σαν κλάσμα του g. 
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Η παραπάνω εξίσωση της επιτάχυνσης αλλάζει μορφή ανάλογα με το είδος της 

συνάρτησης πλάτους που χρησιμοποιείται κάθε φορά. Τέσσερις περιπτώσεις επιτάχυνσης 

συνήθως μελετώνται και είναι πολύ σημαντική η σχέση μεταξύ του μέγιστου πλάτους της 

επιτάχυνσης gp  και της διάρκειας του 0t . Οι 4 περιπτώσεις είναι οι εξής:  
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•
gx pf  

• ogx t/withtsinpf  

• ogx t2/withtcospf  

• o
t

gx t/withtsinepf  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 2.6: Διαγράμματα επιτάχυνσης συναρτήσει του χρόνου για τις 4 περιπτώσεις που 

αναφέρθηκαν παραπάνω. 

 

Έχει αποδειχτεί ότι δεν υπάρχει συσχέτιση μεταξύ της αιχμής της εδαφικής επιτάχυνσης 

και της αιχμής της περιστροφής ενός κίονα.  

Εν κατακλείδι, μόνο οι στατικές προϋποθέσεις είναι σχετικά αξιόπιστες καθώς οι 

δυναμικές εξαρτώνται από πολλούς απρόβλεπτους παράγοντες και μπορεί να οδηγήσουν 

σε λανθασμένες εκτιμήσεις. 

Michaltsos and Raftoyiannis [10] 

2.3.6 Απόσβεση του σεισμού 

Η απόσβεση του σεισμού έχει πολύ σημαντική επίδραση στην κίνηση και ακόμα και 

για μικρές τιμές του συντελεστή απόσβεσης το αποτέλεσμα είναι ορατό. Ο συντελεστής 

απόσβεσης β είναι ένας κρίσιμος παράγοντας που μπορεί να αλλάξει την κίνηση από 

ασταθή σε σταθερή και σύμφωνα με παλαιότερες μελέτες για β<0.5  η κίνηση είναι 

ασταθής.  

Γενικά, η οποιαδήποτε πρόβλεψη της συμπεριφοράς δεν είναι ασφαλής, καθώς και η 

μικρότερη και ακαριαία αλλαγή σε έναν από τους παραπάνω παράγοντες μπορεί να 

οδηγήσει σε μη σταθερή κίνηση. 

Michaltsos and Raftoyiannis [10] 
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2.4 Συμπεράσματα άλλων εργασιών 

Μεταξύ δύο γεωμετρικά ομοίων block που υποβάλλονται στην ίδια εδαφική διέγερση 

και έχουν την ίδια παράμετρο στιβαρότητας α, το block που είναι πιο κοντό είναι λιγότερο 

σταθερό . 

)1(
0

1

0

1

0

1 nn
R

R

b

b

h

h

                                                                              (3) 

Η ροπή αντίστασης του ψηλότερου block είναι n 3  φορές μεγαλύτερη από αυτή του 

κοντύτερου block, το οποίο είναι ουσιαστικά πιο ευαίσθητο σε ανατροπή. Η αύξηση του 

ύψους ενός ορθογωνικού άκαμπτου block με σταθερή παράμετρο α το καθιστά πιο 

σταθερό έναντι ανατροπής. Το ίδιο συμβαίνει και με την αύξηση της γωνίας του 

ορθογωνικού block. 

Ακόμη, όσο πιο ψηλό είναι το άκαμπτο block γίνεται μεγαλύτερο και το ελάχιστο 

πλάτος επιτάχυνσης, ανεξάρτητα από την διάρκεια της διέγερσης και της παραμέτρου α. 

Kounadis (2012) [18] 

 

Οι μετατοπίσεις των κιόνων κατά τη διάρκεια της σεισμικής διέγερσης και οι μόνιμες 

ολισθήσεις μεταξύ των σπονδύλων μετά το πέρας του σεισμού αυξάνονται. Οι 

μετατοπίσεις, όμως, των δοκών των επιστυλίων μειώνονται δραστικά και σαν αποτέλεσμα 

μειώνεται ο κίνδυνος κατάρρευσης των επιστυλίων και ο κίνδυνος των κρούσεων μεταξύ 

τους, που είναι αρκετά επιζήμιος. 

Δασίου,  Μουζάκης, Ψυχάρης, Παπαντωνόπουλος, Βάγιας (2008) [5] 
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Κεφάλαιο 3ο - Γεωμετρικά χαρακτηριστικά, ιδιότητες 

υλικών  και η συνάρτηση της επιτάχυνσης. 

3.1 Εισαγωγή 

Σε αυτό το κεφάλαιο περιγράφονται τα γεωμετρικά χαρακτηριστικά του εξεταζόμενου 

φορέα, καθώς και οι ιδιότητες του υλικού τους. Ακόμη, παρουσιάζεται και περιγράφεται 

αναλυτικά η συνάρτηση της επιτάχυνσης και δίνονται οι τρεις διαφορετικές περιπτώσεις 

που θα χρησιμοποιηθούν και θα συγκριθούν. 

3.2 Γεωμετρικά χαρακτηριστικά του φορέα 

Ο φορέας που εξετάζεται στην παρούσα εργασία αποτελείται από 2 πανομοιότυπους 

κίονες οι οποίοι στηρίζονται σε ένα θεμέλιο και συνδέονται στις κορυφές τους με ένα 

επιστύλιο. 

Οι δύο κίονες αποτελούνται από 3 σπονδύλους ίδιου ύψους, των οποίων η διάμετρος 

μειώνεται προς τα πάνω, δηλαδή έχουν ένταση. Οι τρεις σπόνδυλοι είναι κυλινδρικοί και 

έχουν ύψος 2 μέτρα. Το βασικό χαρακτηριστικό των σπονδύλων αυτών είναι ότι η γωνία 

κατά την οποία μειώνεται η διάμετρος τους είναι κοινή και για τους τρεις. Στα σημεία 

επαφής η διάμετρος κορυφής του υψηλότερου είναι ίδια με τη διάμετρο βάσης του 

χαμηλότερου.  

Πίνακας 3.2.1: Οι διαστάσεις των 3 σπονδύλων αναλυτικά. 

Όπως φαίνεται και στον πίνακα η διαφορά διαμέτρου βάσης-κορυφής για κάθε σπόνδυλο 

είναι 0.07 μέτρα. Το επιστύλιο και το θεμέλιο είναι και τα δύο ορθογωνικού σχήματος. 

Πίνακας 3.2.2: Οι διαστάσεις του επιστυλίου και του θεμελίου αναλυτικά. 

 

 

 

 

 

 

 

  1ος ΣΠΟΝΔΥΛΟΣ 2ος ΣΠΟΝΔΥΛΟΣ 3ος ΣΠΟΝΔΥΛΟΣ 

ΔΙΑΜΕΤΡΟΣ ΒΑΣΗΣ  

(m) 
1.11 1.04 0.97 

ΔΙΑΜΕΤΡΟΣ ΚΟΡΥΦΗΣ (m) 1.04 0.97 0.9 

ΥΨΟΣ  

(m) 
2.00 2.00 2.00 

  ΕΠΙΣΤΥΛΙΟ ΘΕΜΕΛΙΟ 

Μήκος 

 (m) 2.7 4.5 

Πλάτος  

(m) 0.7 2 

Ύψος  

(m) 1 1 
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3.3 Το υλικό και οι ιδιότητες του 

Ολόκληρος ο φορέας που εξετάζεται στην εργασία αυτή είναι από μάρμαρο. Το 

μάρμαρο είναι πέτρωμα αποτελούμενο κατά το μέγιστο ποσοστό του από ασβεστίτη. Είναι 

προϊόν ανακρυστάλλωσης ασβεστολίθων. Χαρακτηρίζεται από μεγάλη δυσκαμψία που 

ουσιαστικά το καθιστά άκαμπτο. Η σκληρότητα του είναι 3-4 και το ειδικό βάρος του 

ποικίλλει από 1.8 έως 2.85 περίπου.[3] 

Όμως όσον αφορά τις μηχανικές ιδιότητες του μαρμάρου, διαπιστώνεται στη 

βιβλιογραφία μεγάλη διασπορά τιμών, όπως είναι το μέτρο ελαστικότητας και ο λόγος του 

Poisson [Ζάμπας,1994][39]. Η διασπορά αυτή οφείλεται κατά κύριο λόγο στις 

διαφορετικές συνθήκες πραγματοποίησης των πειραμάτων και στο γεγονός ότι το υλικό 

είναι εγκαρσίως ισότροπο [Κουρκούλης,1999][20]. Για την απλοποίηση της εφαρμογής 

και επειδή μία διεύθυνση διέπει κυρίως την απόκριση, χρησιμοποιήθηκαν μέσες τιμές για 

το μέτρο ελαστικότητας (Ε=84.5 GPA), για το λόγο του Poisson (ν=0.26) και για την 

πυκνότητα (ρ=2750 kg/m 3 ). 

Δασίου, Ψυχάρης ,Βάγιας (2008) [4] 

Πίνακας 3.3.1: Οι μηχανικές ιδιότητες του μαρμάρου αναλυτικά. 

 

 

 

 

 

3.4 Η συνάρτηση της επιτάχυνσης 

Η συνάρτηση της επιτάχυνσης που χρησιμοποιήθηκε ήταν damped half sine-wave 

pulse, δηλαδή συνάρτηση απόσβεσης μισού ημιτονοειδούς παλμού και ο τύπος της ήταν ο 

εξής: 
o

t

gx ttepf /sin  όπου: 

[Michaltsos and Raftoyiannis][10] 

α) p g  είναι το μέγιστο πλάτος της επιτάχυνσης 

β) β είναι ο συντελεστής απόσβεσης του σεισμού 

γ) t  είναι  o χρόνος μέσα στον οποίο ολοκληρώνεται ένας κύκλος της ημιτονοειδούς 

συνάρτησης και εδώ λήφθηκε τέτοιος, έτσι ώστε η συνάρτηση να είναι υψηλής 

συχνότητας. 

δ) σαν βήμα χρόνου t δόθηκε 0.01 (ίσο με το increment size που θα οριστεί παρακάτω στο 

Step Apply Acceleration). 

Δόθηκαν 3 διαφορετικά amplitude για την επιτάχυνση με διαφορετικές τιμές για 

κάποιους όρους της συνάρτησης: 

α) p g =0.5g=4.905 m/s
2

, β=0.5, t =0.050sec, t=0.01sec. 

β) p g =0.5g=4.905 m/s
2

, β=0.5, t =0.025sec, t=0.01sec. 

γ) p g =0.3g=2.943 m/s
2

, β=0.5, t =0.050sec, t=0.01sec 

Οι τιμές της επιτάχυνσης σε συνάρτηση με το χρόνο με βάση τη συγκεκριμένη συνάρτηση 

υπολογίσθηκαν μέσω του Microsoft Excel και αντιγράφηκαν στο Abaqus. 

Για αυτές τις  τρεις περιπτώσεις επιτάχυνσης που εισήχθησαν στο Abaqus μελετήθηκε ο 

φορέας και βγήκαν τα αντίστοιχα αποτελέσματα.  

 

ΜΕΤΡΟ ΕΛΑΣΤΙΚΟΤΗΤΑΣ Ε  

(GPa) 
84.5 

ΛΟΓΟΣ ΤΟΥ POISSON (ν) 0.26 

ΠΥΚΝΟΤΗΤΑ ρ  

(kg/m^3) 
2750 
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Κεφάλαιο 4ο – Μοντελοποίηση με τη μέθοδο των 

πεπερασμένων στοιχείων Abaqus  

4.1 Εισαγωγή 

Καθώς η συμπεριφορά είναι έντονα μη γραμμική, η αναλυτική προσέγγιση γίνεται 

πρακτικά αδύνατη και η ανάλυση πραγματοποιείται με αριθμητικές μεθόδους με τη χρήση 

προγραμμάτων πεπερασμένων στοιχείων. 

Στο κεφάλαιο αυτό περιγράφεται η διαδικασία της μοντελοποίησης με τη μέθοδο των 

πεπερασμένων στοιχείων και η εισαγωγή των δεδομένων στο πρόγραμμα Abaqus. 

Παρατίθενται αναλυτικά τα βήματα που ακολουθήθηκαν για την εισαγωγή της γεωμετρίας 

του φορέα, τον καθορισμό του υλικού, την εφαρμογή των αλληλεπιδράσεων, τη 

δημιουργία της συνδεσμολογίας,  την επιβολή των συνοριακών συνθηκών, την εφαρμογή 

των φορτίων και τη δημιουργία του πλέγματος. 

 Στο πρόγραμμα οι κίονες προσομοιώνονται ως τρισδιάστατα άκαμπτα σώματα με 

στοιχεία επαφής. Οι αρχιτεκτονικές λεπτομέρειες των επιστυλίων και οι ραβδώσεις των 

κιόνων αγνοήθηκαν. 

4.2 Η μέθοδος των πεπερασμένων στοιχείων 

Η μέθοδος των πεπερασμένων στοιχείων είναι μια αριθμητική μέθοδος (δηλ. μέθοδος 

υπολογισμού με χρήση Η/Υ) για τον υπολογισμό προσεγγιστικών λύσεων μερικών 

διαφορικών εξισώσεων. 

Η διαδεδομένη χρήση της μεθόδου οφείλεται στο γεγονός ότι παρουσιάζεται ως ενιαίο 

εργαλείο για τη στατική και δυναμική γραμμική και μη-γραμμική ανάλυση των 

κατασκευών  από ραβδωτούς, επιφανειακούς και χωρικούς φορείς ή συνδυασμό τους, για 

οποιοδήποτε  γεωμετρικό σχήμα, φόρτιση και συνοριακές συνθήκες. 

Η μέθοδος των πεπερασμένων στοιχείων αποτελείται από τρία στάδια: 

1. Το πρώτο στάδιο συνίσταται στην υποδιαίρεση και διάσπαση της κατασκευής σε ένα, 

ανάλογα με την επιθυμητή ακρίβεια, μικρότερο ή μεγαλύτερο πλήθος στοιχείων 

πεπερασμένων διαστάσεων (elements), τα οποία εφάπτονται μεταξύ τους χωρίς να 

αφήνουν κανένα κενό και συνδέονται με τους κόμβους (nodes) που βρίσκονται στα 

σύνορα των στοιχείων. Το σύνολο αυτό των στοιχείων ονομάζεται δίκτυο ή πλέγμα (mesh) 

και η προσομοίωση του φορέα με το δίκτυο των πεπερασμένων στοιχείων ονομάζεται 

διακριτοποίηση του φορέα (discretization). 

2. Στο δεύτερο βήμα, μετά τη διακριτοποίηση της κατασκευής, θεωρείται κάθε τέτοιο 

πεπερασμένο στοιχείο ξεχωριστά και για το λόγο αυτό αποσπάται από το σύμπλεγμα των 

στοιχείων που συνθέτουν την κατασκευή.  

3. Αφού μελετηθεί και καθορισθεί η μηχανική συμπεριφορά κάθε στοιχείου ακολουθεί το 

τρίτο βήμα της διαδικασίας επίλυσης που είναι η σύνθεση της κατασκευής από τα 

επιμέρους πεπερασμένα στοιχεία, η κατάλληλη δηλαδή επανασύνδεση των στοιχείων προς 

σχηματισμό της διακριτοποιημένης κατασκευής. Η μηχανική συμπεριφορά κάθε στοιχείου 

καθορίζεται συνήθως από τη σχέση ανάμεσα στις δυνάμεις και τις μετατοπίσεις στους 

κόμβους του. 

Ωστόσο, η μέθοδος των πεπερασμένων στοιχείων είναι προσεγγιστική εφόσον ο 

αρχικός συνεχής φορέας (κατασκευή), για να μπορέσει να επιλυθεί, μετατρέπεται σε ένα 
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ασυνεχές σύμπλεγμα πεπερασμένων στοιχείων. Όσο περισσότερα πεπερασμένα στοιχεία 

χρησιμοποιούνται για την κατασκευή του ασυνεχούς μοντέλου υπολογισμού του αρχικού 

φορέα, όσο πιο ακριβές δηλαδή είναι το μηχανικό/υπολογιστικό προσομοίωμα του 

πραγματικού συστήματος, τόσο ακριβέστερα μπορούν να θεωρηθούν γενικώς τα 

αποτελέσματα (εφόσον βέβαια και η μηχανική συμπεριφορά των χρησιμοποιούμενων 

στοιχείων περιγράφεται ικανοποιητικά). 

 

Γενικές αρχές της μεθόδου των πεπερασμένων στοιχείων 

Στη μέθοδο των πεπερασμένων στοιχείων το στοιχείο είναι η βασική δομική μονάδα 

µε προκαθορισμένο αριθμό βαθμών ελευθερίας.  

Το πλέγμα προσομοιάζει µε ιστό αράχνης, στον οποίο από κάθε κόμβο εκτείνεται ένα 

στοιχείο πλέγματος σε κάθε γειτονικό κόμβο. Το πλέγμα προγραμματίζεται ώστε να 

περιέχει τις δομικές ιδιότητες και τις ιδιότητες υλικού που καθορίζουν µε ποιο τρόπο θα 

συμπεριφερθεί µία κατασκευή υπό ορισμένες συνθήκες φόρτισης. 

Οι κόμβοι τοποθετούνται µε ορισμένη πυκνότητα εντός του υλικού ανάλογα µε τα 

επίπεδα τάσης που αναπτύσσονται σε κάθε συγκεκριμένη περιοχή. Περιοχές µε 

μεγαλύτερη αναμενόμενη τάση θα έχουν μεγαλύτερη πυκνότητα κόμβων από αυτές που η 

αναμενόμενη τάση είναι μικρότερη. 

Η επιλογή της κατάλληλης πυκνότητας πεπερασμένων στοιχείων του πλέγματος (mesh 

density) είναι σημαντικός παράγοντας επιτυχίας του μοντέλου, προκειμένου να επιλυθεί το  

υπό μελέτη πρόβλημα. 

Κουμούσης (1998) [2]  

4.3 Γενικά για το Abaqus 

Αρχικά πρέπει να αναφερθούν ορισμένα βασικά στοιχεία σχετικά με το πρόγραμμα 

πεπερασμένων στοιχείων Abaqus, όπως οι μονάδες μέτρησης που θα χρησιμοποιηθούν, οι 

βαθμοί ελευθερίας που θα εμφανίζονται και οι ομάδες  εντολών που θα επιλεγούν. 

4.3.1 Οι μονάδες μέτρησης 

Το  Abaqus δεν έχει προκαθορισμένες μονάδες για κανένα φυσικό μέγεθος, εκτός από 

τις περιστροφές και τις γωνίες. Επομένως, οι μονάδες μέτρησης που θα χρησιμοποιηθούν 

πρέπει να ανήκουν σε ένα ενιαίο και σταθερό σύστημα μονάδων χωρίς συντελεστές 

μετατροπής. Στην συγκεκριμένη εργασία επιλέχθηκε το διεθνές σύστημα μονάδων SI. 

Επομένως τα μεγέθη που χρησιμοποιήθηκαν εκφράστηκαν στις εξής μονάδες: 

• το μήκος σε m (μέτρα) 

• η μάζα σε  kg (κιλά) 

• ο χρόνος σε sec (δευτερόλεπτα)  

• η δύναμη σε kN  

• η επιτάχυνση σε m/s
2
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4.3.2 Οι βαθμοί ελευθερίας  

Πρέπει να αναφερθεί ότι οι βαθμοί ελευθερίας περιγράφονται με τους παρακάτω 

δείκτες: 

Για μετατόπιση κατά την διεύθυνση του άξονα x, y, z  οι δείκτες που χρησιμοποιούνται 
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είναι 1, 2, 3 αντίστοιχα. Για περιστροφή γύρω από τον άξονα x, y ,z σε rad οι δείκτες που 

χρησιμοποιούνται είναι 4, 5, 6 αντίστοιχα. 

Abaqus Documentation [6] 

4.3.3 Οι ομάδες εντολών στο Abaqus 

Το Abaqus έχει πακέτα εντολών, δηλαδή για κάθε ξεχωριστό μέρος του προβλήματος 

υπάρχει μία ομάδα εντολών που το αφορά. Επιλέγεται η κατηγορία της ενέργειας που θα 

πραγματοποιηθεί και εμφανίζονται τα αντίστοιχα εικονίδια δίπλα στο σκίτσο και αλλάζουν 

οι επιλογές στη γραμμή εντολών. Όταν ο χρήστης έχει εισέλθει στην κατηγορία εντολών 

που θέλει να εφαρμόσει, τότε μπορεί να επιλέξει εντολή, είτε από τα εικονίδια που 

υπάρχουν δίπλα στο σκίτσο, είτε από τη γραμμή εντολών. 

Οι 10 κατηγορίες εντολών που υπάρχουν στο Abaqus είναι οι εξής: 

•part: αφορούν τη δημιουργία των μερών του μοντέλου. 

•property: ορίζουν  ιδιότητες, υλικά. 

•assembly: αφορούν τη σύνδεση των μερών.  

•step: σχετίζονται με το είδος της ανάλυσης και την επόπτευση της διαδικασίας. 

•interaction: προσδιορίζουν πώς αλληλεπιδρούν τα μέρη που είναι σε επαφή. 

•load: έχουν σχέση με την επιβολή φορτίων και τη δημιουργία  συνοριακών συνθηκών. 

•mesh: δημιουργούν το πλέγμα. 

•job: υποβάλλουν την ανάλυση σε επεξεργασία. 

•visualization: προβάλλουν τα αποτελέσματα της επεξεργασίας. 

•sketch: σχεδιάζουν σκίτσα σχετικά με το θέμα που μελετάται. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.3.1: Απεικονίζονται οι 10 κατηγορίες εντολών στα δεξιά, ενώ στα αριστερά είναι τα 

εικονίδια που αφορούν εντολές της κατηγορίας Part. 
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4.4 Εισαγωγή δεδομένων στο πρόγραμμα Abaqus 

 
4.4.1 Η δημιουργία της γεωμετρίας του φορέα 

Αρχικά στο πρόγραμμα σχεδιάστηκε ξεχωριστά κάθε σπόνδυλος, το θεμέλιο και το 

επιστύλιο με την χρησιμοποίηση των εργαλείων σχεδίασης που παρέχει το Abaqus. Η 

αρχή έγινε με τον πρώτο σπόνδυλο χρησιμοποιώντας την εντολή Part=>Create (Μέρος=> 

Δημιουργία). Part είναι η γεωμετρία ενός δομικού στοιχείου. Με την εντολή αυτή 

τοποθετήθηκαν επιλογές για το μέρος, όπως το ότι είναι τρισδιάστατο και διακριτά 

άκαμπτο. Ο πρώτος σπόνδυλος έχει διάμετρο βάσης 1.11 μέτρα, διάμετρο κορυφής 1.04 

μέτρα και ύψος 2.00 μέτρα. Ακολούθησε η σχεδίαση του 1
ου

  σπονδύλου στο σκίτσο αφού 

πρώτα λήφθηκε  υπόψη η  μείωση της διαμέτρου με την  αύξηση του ύψους  και 

επιλέχθηκε  η κατάλληλη γωνία, που ήταν -1.002573 μοίρες. 

 

 

Εικόνα 4.4.1.1: Στα αριστερά απεικονίζεται το εικονίδιο που αφορά την εντολή Create Part, 

στη μέση οι επιλογές για τρισδιάστατο διακριτά άκαμπτο στοιχείο και δεξιά το ύψος και η γωνία 

του σπονδύλου. 

 

Έτσι σχεδιάστηκε το πρώτο στερεό σώμα και κατόπιν επιλέχθηκε ως σημείο αναφοράς 

το κέντρο βάρους του. Αυτό έγινε σκοπίμως, γιατί τα άκαμπτα σώματα στο Abaqus 

εκπροσωπούνται από ένα σημείο, το σημείο αναφοράς, το οποίο περιγράφει την κίνηση 

του σώματος. Στο σημείο αυτό ασκούνται οι περιορισμοί των βαθμών ελευθερίας του 

σώματος. Η επιλογή του έγινε με τη χρήση της εντολής Tools=>Reference Point 

(Εργαλεία=>Σημείο Αναφοράς) και την επιλογή των συντεταγμένων του σημείου που 

έπρεπε να οριστεί σαν σημείο αναφοράς. 
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Εικόνα 4.4.1.2: Η εντολή Tools=>Reference point για την επιλογή του σημείου αναφοράς. 

 

 

 
 

Εικόνα 4.4.1.3: Η επιλογή των συντεταγμένων του σημείου αναφοράς του πρώτου σπονδύλου. 

 

Για κάθε σώμα προτιμήθηκε το σημείο αναφοράς του να είναι το κέντρο μάζας του. 

Παρότι όλα τα σώματα που χρησιμοποιήθηκαν είχαν βασικά γεωμετρικά σχήματα και ο 

προσδιορισμός τους δεν ήταν δύσκολος για λόγους επαλήθευσης χρησιμοποιήθηκε η 

εντολή Tools=>Query=>Mass properties (Εργαλεία=>Απορία=>Ιδιότητες Μάζας) και οι 

συντεταγμένες του κέντρου μάζας κάθε σώματος εμφανίστηκαν από το πρόγραμμα. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.1.4: Στα αριστερά η εντολή Tools=>Query και στα δεξιά το εικονίδιο της εντολής 

Query και η επιλογή Mass properties. 
 

Ακόμη, χρησιμοποιήθηκε η εντολή Tools=>Datum (Εργαλεία=>Δεδομένα) για την 

επιλογή σημείων, αξόνων και ενός συστήματος συντεταγμένων. Datum στο Abaqus είναι 

βοηθητικό χαρακτηριστικό που χρησιμοποιείται για αναφορά, όταν δημιουργείται ένα part 

ή η συνδεσμολογία του μοντέλου. Μπορεί να έχει τη μορφή σημείων, αξόνων, πλακών και 

συστημάτων συντεταγμένων. Σε όλους τους σπονδύλους επιλέχθηκε ως Datum ο άξονας 

συμμετρίας τους, ενώ στο θεμέλιο και στο επιστύλιο επιλέχθηκαν οι κορυφές των ακμών 

τους. Ό,τι επιλέχθηκε ως Datum απεικονίζεται με κίτρινο χρώμα. 
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Εικόνα 4.4.1.5: Στα αριστερά η επιλογή Tools=>Datum και στα δεξιά τα είδη που μπορούν να 

επιλεγούν. 

 

Πραγματοποιήθηκε ακριβώς η ίδια διαδικασία για το δεύτερο και τον τρίτο σπόνδυλο 

με τη μόνη διαφορά στις διαμέτρους τους, καθώς όλοι οι σπόνδυλοι έχουν το ίδιο ύψος 

που είναι 2.00 μέτρα. Ο δεύτερος σπόνδυλος έχει διάμετρο βάσης 1.04 μέτρα και διάμετρο 

κορυφής 0.97 μέτρα και ο τρίτος σπόνδυλος διάμετρο βάσης 0.97 μέτρα και διάμετρο 

κορυφής 0.9 μέτρα. Στις επιφάνειες επαφής τους οι τρεις σπόνδυλοι έχουν ακριβώς τις 

ίδιες διαμέτρους και ουσιαστικά είναι σαν να ταυτίζεται η βάση του ενός με την κορυφή 

του άλλου. 

 

 
 

Εικόνα 4.4.1.6: Ο πρώτος σπόνδυλος με μαύρο χρώμα. 
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Εικόνα 4.4.1.7: Ο δεύτερος σπόνδυλος με μπλε χρώμα. 

 
Εικόνα 4.4.1.8: Ο τρίτος σπόνδυλος με κόκκινο χρώμα. 

 

      Ακολούθησε η σχεδίαση του θεμελίου και του επιστυλίου τα οποία είναι και αυτά 

διακριτά και άκαμπτα και είναι και τα δύο ορθογωνικού σχήματος. Το θεμέλιο έχει 4.50 

μέτρα μήκος, 2.00 μέτρα πλάτος και 1.00 μέτρο πάχος. Το επιστύλιο έχει 2.70 μέτρα 

μήκος, 0.70 μέτρα πλάτος και 1.00 μέτρο ύψος. Όπως και στους σπονδύλους, επιλέχθηκαν 

σαν σημεία αναφοράς τα κέντρα βάρους του θεμελίου και του επιστυλίου αντίστοιχα. 
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Εικόνα 4.4.1.9: Απεικονίζεται το θεμέλιο με κίτρινο χρώμα και το επιστύλιο με πράσινο χρώμα. 
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4.4.2 Ο ορισμός του υλικού 

Αφού ολοκληρώθηκε η  σχεδίαση του κάθε κομματιού τρισδιάστατα, συνεχίστηκε η 

διαδικασία προσδιορισμού των ιδιοτήτων και ο ορισμός του υλικού. Εφόσον όλο το 

σύστημα είναι μαρμάρινο, το υλικό ορίστηκε μία φορά. Χρησιμοποιήθηκαν μέσες τιμές 

για το μέτρο ελαστικότητας (Ε=84.5 GPA), για το λόγο του Poisson (ν=0.26) και για την 

πυκνότητα (ρ=2750 kg/m 3 ). Η εισαγωγή των τιμών αυτών έγινε με την εντολή 

Material=>Create (Υλικό=>Δημιουργία) από την ομάδα εντολών που αφορούν ιδιότητες. 

 

 

  

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.2.1: Στα δεξιά η εντολή Material=>Create και στα αριστερά το εικονίδιο της. 
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Εικόνα 4.4.2.2: Οι τιμές για το μέτρο ελαστικότητας και το λόγο του Poisson. 
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Εικόνα 4.4.2.3: Η τιμή για το ειδικό βάρος του μαρμάρου.  
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4.4.3 Ο προσδιορισμός της μάζας και της περιστροφικής αδράνειας 

Μετά τον ορισμό του υλικού ακολούθησε η εντολή Section (Τμήμα). To τμήμα 

περιέχει πληροφορίες για τις ιδιότητες ενός μέρους ή για μία περιοχή ενός μέρους και τις 

περισσότερες φορές το τμήμα αναφέρεται σε όνομα υλικού. Οι πληροφορίες που 

απαιτούνται για τον ορισμό ενός τμήματος εξαρτώνται από το είδος της περιοχής ή του 

μέρους. Για παράδειγμα, στη συγκεκριμένη περίπτωση που όλα τα μέρη του φορέα είναι 

άκαμπτα, χρειάστηκε να επιλεχθούν τμήματα τα οποία περιγράφουν ιδιότητες μάζας. Έτσι 

πρέπει για όλα τα μέρη που παρήχθησαν (εφόσον όλα είναι άκαμπτα) να οριστεί η 

αδράνεια τους. Αυτό πραγματοποιήθηκε επιλέγοντας από την γραμμή εντολών (όταν 

βρισκόμαστε στις εντολές που αφορούν ιδιότητες) Special=>Inertia=>Create 

(Ειδικά=>Αδράνεια=>Δημιουργία) 
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Εικόνα 4.4.3.1: Απεικονίζεται η εντολή Special=>Inertia=>Create. 

 

Επιλέχθηκε σημειακή μάζα/ αδράνεια, συμπληρώνοντας τα δεδομένα μάζας για κάθε 

μέρος του μοντέλου που είχε  δημιουργηθεί και  αντιστοιχήθηκε  στο κέντρο βάρους κάθε 

μέρους. 

 

 

 
Εικόνα 4.4.3.2: Απεικονίζεται η επιλογή σημειακής μάζας στα αριστερά, καθώς και η τοποθέτηση 

της τιμής της μάζας και των τιμών της περιστροφικής αδράνειας γύρω από τους 3 άξονες για τον 

τρίτο σπόνδυλο στα δεξιά. 

 

Η μάζα κάθε στοιχείου υπολογίσθηκε πολλαπλασιάζοντας το ειδικό βάρος του μαρμάρου 

που έχει τιμή 2750 kg/m
3
επί τον όγκο του κάθε στοιχείου. Οι τιμές των περιστροφικών 

ροπών αδράνειας υπολογίσθηκαν: 

α)για τους σπονδύλους από τους τύπους: 
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β)για το θεμέλιο και το επιστύλιο από τους τύπους:  

 

 

 

 

 

 

 

 

 

 

 

 

[22] 

 

Με αυτόν τον τρόπο δόθηκαν στοιχεία για τη μάζα και την περιστροφική αδράνεια όλων 

των μερών του μοντέλου. 

Πίνακας 4.4.3.1: Παρουσιάζονται συγκεντρωτικά οι τιμές της μάζας και της περιστροφικής 

αδράνειας γύρω από τους 3 άξονες για όλα τα μέρη του μοντέλου. 

Πρέπει να αναφερθεί ότι για λόγους απλοποίησης για τους σπονδύλους 

χρησιμοποιήθηκαν, τόσο για τον υπολογισμό του όγκου, όσο και για τον υπολογισμό της 

περιστροφικής αδράνειας, οι τύποι για κύλινδρο ίδιας ακτίνας σε βάση και κορυφή, καθώς 

η διαφορά τους στο συγκεκριμένο μοντέλο είναι 0.035m και θεωρήθηκε πολύ μικρή. 

Στους τύπους χρησιμοποιήθηκε η ακτίνα της βάσης που ήταν και η μεγαλύτερη. 

Abaqus Documentation [6] 

  1
ος

 Σπόνδυλος 2
ος

 Σπόνδυλος 3
ος

 Σπόνδυλος Θεμέλιο Επιστύλιο 

Μάζα(kg) 5324 4672.25 4064.5 24750 5197.5 

I11(kg*m
2

) 2184.65 1873.26 1593.85 10312.5 645.356 

I22(kg*m
2

) 2184.65 1873.26 1593.85 43828.1 3590.61 

I33(kg*m
2

) 819.963 631.688 478.036 50015.6 3369.71 
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4.4.4 Η δημιουργία της συνδεσμολογίας 

Μετά τον ορισμό της αδράνειας εξήλθαμε  από τις εντολές που αφορούν ιδιότητες και 

εισήλθαμε  στις εντολές  Assembly (η συνδεσμολογία). Χρειάστηκε να χρησιμοποιηθούν 

αυτές οι εντολές, αφού μπορεί να είχαν δημιουργηθεί τα μέρη, αλλά αυτά υπήρχαν το 

καθένα στο δικό του σύστημα συντεταγμένων και ήταν ανεξάρτητο από τα υπόλοιπα. Στο 

πακέτο εντολών Assembly (συνδεσμολογία) δημιουργούνται instances (παραδείγματα 

των μερών που έχουν ήδη φτιαχτεί) με την εντολή Instance=>Create 

(Παράδειγμα=>Δημιουργία) και τοποθετούνται με τέτοιο τρόπο, έτσι ώστε να  σχετίζονται 

το ένα με το άλλο. Αυτό επιτυγχάνεται δημιουργώντας position constraints (περιορι-

σμούς θέσης) οι οποίοι, είτε  ευθυγραμμίζουν επιλεγμένες πλευρές, κορυφές, ή επιφάνειες, 

είτε εφαρμόζουν απλές μετακινήσεις και περιστροφές. 

Προτού να δημιουργηθούν τα παραδείγματα των μερών έπρεπε πρώτα να μετατραπούν 

τα στερεά άκαμπτα μέρη  σε κελύφη, καθώς σε αντίθετη περίπτωση δεν γινόταν δεκτό από 

το Abaqus να δημιουργηθούν παραδείγματα  για τα μέρη. Αυτή η μετατροπή επετεύχθη με 

την εντολή Shape=>Shell=>From solid (Σχήμα=>Κέλυφος=>Από Στερεό), η οποία 

βρίσκεται στην κατηγορία εντολών part, για όλα τα μέρη  του μοντέλου. Η εντολή αυτή 

χρησιμοποιήθηκε  επιλέγοντας κάθε φορά όλη τη γεωμετρία του κάθε μέρους και με αυτόν 

τον τρόπο μετατράπηκαν τα μέρη σε κελύφη. 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.4.1: Η εντολή Shape=>Shell=>From solid. 

 

Τα instances (παραδείγματα ενός μέρους) που φτιάχνονται στην κατηγορία εντολών 

assembly (συνδεσμολογία) διατηρούν τη σχέση τους με τα αρχικά μέρη. Δηλαδή, εάν 

τροποποιηθεί ένα μέρος γεωμετρικά, τότε θα αλλάξει και η γεωμετρία του  παραδείγματός 

του αυτόματα από το πρόγραμμα. Ένα παράδειγμα ενός μέρους μπορεί να χρησιμοποιηθεί, 

όσες φορές απαιτείται στην εντολή assembly (συνδεσμολογία). Με άλλα λόγια, ένα μέρος 

μπορεί να υπάρχει πολλές φορές στην συνδεσμολογία, η οποία όμως είναι μόνο μία. 

Τα παραδείγματα των μερών επιλέγονται να είναι dependent (εξαρτώμενα) ή 

independent (ανεξάρτητα) και εφόσον επιλεχθεί ένα να είναι κάτι από τα δύο, τότε και τα 

υπόλοιπα είναι και αυτά το ίδιο. Τα dependent instances (εξαρτώμενα παραδείγματα 

μερών) είναι ένας απλός δείκτης για τα αρχικά μέρη και μοιράζονται μόνο την ίδια 

γεωμετρία, ενώ το πλέγμα ορίζεται στο μέρος και όχι στο παράδειγμα του. Στα 

independent instances (ανεξάρτητα παραδείγματα μερών) το πλέγμα ορίζεται σε αυτά και 
όχι στα αρχικά μέρη. Τα dependent instances (εξαρτώμενα παραδείγματα μερών) έχουν 

το πλεονέκτημα ότι χρειάζεται να κατασκευαστεί το  πλέγμα σε κάθε μέρος μία φορά και 

πριν φτάσει η διαδικασία στην εντολή assembly. Στα independent πρέπει να φτιαχτεί το 

πλέγμα σε καθένα από αυτά ξεχωριστά στην εντολή assembly. 

Επιλέχτηκαν στην εντολή assembly dependent instances (εξαρτώμενα παραδείγματα 

μερών) και από μία φορά το θεμέλιο, το επιστύλιο και οι 3 σπόνδυλοι. 
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Εικόνα 4.4.4.2: Απεικονίζεται η εντολή Instance=>Create και φαίνεται επίσης η επιλογή να είναι 

dependent instance. 

 

Οι περιορισμοί θέσης που επιβλήθηκαν ήταν 2: 

1
ον

) περιορισμός face to face(πρόσωπο με πρόσωπο). Χρησιμοποιήθηκε η εντολή 

Constraint=>Face to Face (περιορισμός=>πρόσωπο με πρόσωπο). Στον περιορισμό αυτό 

επιλέγονται δύο πρόσωπα διαφορετικών μερών και αλλάζει η θέση του μέρους που 

επιλέχθηκε το πρώτο πρόσωπο προς την κατεύθυνση που δείχνουν τα βέλη που 

εμφανίζονται και στα 2 πρόσωπα, αλλά και σύμφωνα με την απόσταση που ορίζεται στο 

δεδομένο της clearance (κάθαρση). Με αυτόν τον τρόπο επιτυγχάνεται η τοποθέτηση 

εύκολα και γρήγορα ενός μέρους σε  σχέση με ένα άλλο και γίνονται δύο πρόσωπα 

διαφορετικών μερών παράλληλα και σε ότι απόσταση επιθυμείται. 

2
ον

) περιορισμός coincident point (συμπίπτοντος σημείου). Χρησιμοποιείται η εντολή 

Constraint=>Coincident Point (περιορισμός=>συμπίπτων σημείο). Στον περιορισμό 

αυτόν ορίζονται δύο σημεία και το πρόγραμμα τα κάνει να συμπίπτουν μεταξύ τους. 
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Εικόνα 4.4.4.3: Απεικονίζεται στα αριστερά το εικονίδιο του περιορισμού θέσης face to face, στα 

δεξιά η επιλογή της κατακόρυφης απόστασης μεταξύ των δύο προσώπων να είναι μηδενική και 

στα δεξιά το εικονίδιο του περιορισμού θέσης coincident point. 
 

 

Εικόνα 4.4.4.4: Η αρχική τοποθέτηση των παραδειγμάτων των μερών στη συνδεσμολογία. 
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Εικόνα 4.4.4.5: Ο πρώτος περιορισμός θέσης face to face που επιβλήθηκε μεταξύ της κορυφής του 

πρώτου σπονδύλου και της βάσης του δεύτερου σπονδύλου. Με τον περιορισμό αυτόν οι δύο 

επιφάνειες έγιναν παράλληλες. 

 

 
Εικόνα 4.4.4.6: Ο πρώτος περιορισμός coincident point μεταξύ των κέντρων κορυφής και βάσης 

του πρώτου και του δεύτερου σπονδύλου αντίστοιχα. Με τον περιορισμό αυτό ταυτίστηκαν τα δύο 

σημεία και κατά συνέπεια οι δύο επιφάνειες. 
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Εικόνα 4.4.4.7: Περιορισμός θέσης face to face μεταξύ κορυφής δεύτερου σπονδύλου και βάσης 

τρίτου σπονδύλου. 

 

 

Εικόνα 4.4.4.8: Περιορισμός coincident point μεταξύ κέντρων κορυφής και βάσης δεύτερου και 

τρίτου σπονδύλου αντίστοιχα. 

 

Σε αυτό το σημείο δημιουργήθηκε το παράδειγμα του θεμελίου στη συνδεσμολογία. 
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Εικόνα 4.4.4.9: Το παράδειγμα του θεμελίου στη συνδεσμολογία. 

 

Οι άξονες z των δύο κιόνων απέχουν 2.70 μέτρα και βρίσκονται πάνω στο θεμέλιο το 

οποίο έχει μήκος 4.50 μέτρα. Αυτό σημαίνει ότι τα κέντρα των βάσεων των πρώτων 

σπονδύλων και κατ’ επέκταση των δύο κιόνων απέχουν από την άκρη του θεμελίου 

εκατέρωθεν 0.90 μέτρα. Χρησιμοποιήθηκε η εντολή Query=>Distance (Απορία=>Από-

σταση) και βρέθηκε η οριζόντια απόσταση μεταξύ του κέντρου της βάσης του κίονα και 

της κορυφής του θεμελίου 2.00 μέτρα. 

 

 
Εικόνα 4.4.4.10: Η απόσταση η οποία μετρήθηκε μέσω της εντολής Query=>Distance. 

 

Χρησιμοποιήθηκε πάλι ο περιορισμός face to face μεταξύ της βάσης του κίονα και της 

κορυφής του θεμελίου, έτσι, ώστε να γίνουν παράλληλες επιφάνειες και σε μηδενική 

απόσταση μεταξύ τους. 
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Εικόνα 4.4.4.11: Περιορισμός face to face μεταξύ της βάσης του κίονα και της κορυφής του 

θεμελίου 

 

Σε αυτό το σημείο επιλέχθηκε η εντολή Instance=>LinearPattern (γραμμική 

αντιγραφή) 2 φορές (την πρώτη φορά έγινε αντιγραφή του κίονα ολόκληρου σε οριζόντια 

απόσταση 2.00+0.90=2.90 μέτρα και τη δεύτερη φορά έγινε αντιγραφή κατά τον άξονα y 

σε απόσταση 1.00 μέτρου) για να τοποθετηθεί  ο πρώτος κίονας στο σημείο που έπρεπε να 

είναι πάνω στο θεμέλιο με βάση και τις αποστάσεις που μετρήθηκαν προηγουμένως. Τα 

αντιγραμμένα στοιχεία που δεν χρησίμευαν πουθενά απλά διαγράφονταν. Αμέσως μετά 

χρησιμοποιήθηκε η ίδια εντολή ξανά για αντιγραφή του πρώτου κίονα κατά τον άξονα x 

σε απόσταση 2.70 μέτρων και έτσι είχαμε και τον δεύτερο κίονα στη σωστή θέση. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.4.12: Στα αριστερά φαίνεται το εικονίδιο της εντολής Instance=>Linear Pattern και 

στα δεξιά οι επιλογές για την απόσταση στην οποία θα γίνει η αντιγραφή τόσο με τιμή όσο και με 

διεύθυνση. 
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Εικόνα 4.4.4.13: Η αντιγραφή του πρώτου κίονα πάνω στο θεμέλιο στη σωστή θέση. 

 

 
Εικόνα 4.4.4.14: Η δημιουργία του δεύτερου κίονα πάνω στο θεμέλιο στη σωστή θέση μέσω της 

εντολής Instance=>Linear Pattern. 

 

Για να ολοκληρωθεί η συνδεσμολογία απέμενε να τοποθετηθεί το επιστύλιο στην 

κορυφή των κιόνων. Αυτό επετεύχθη με τη χρήση των περιορισμών θέσης face to face 

μεταξύ κορυφής 3
ου

 σπονδύλου και κατώτερης οριζόντιας επιφάνειας επιστυλίου  και 

coincident point μεταξύ μέσου ακμής πλάτους επιστυλίου και κέντρου κορυφής 3
ου

 

σπονδύλου. 
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Εικόνα 4.4.4.15: Περιορισμός θέσης face to face μεταξύ κορυφής 3ου σπονδύλου και κατώτερης 

οριζόντιας επιφάνειας επιστυλίου. 

 

 
Εικόνα 4.4.4.16: Περιορισμός θέσης coincident point μεταξύ μέσου ακμής πλάτους επιστυλίου 

και κέντρου κορυφής 3ου σπονδύλου. 

 

Σε αυτό το σημείο ολοκληρώθηκε η συνδεσμολογία και το μοντέλο πήρε την τελική 

γεωμετρική του μορφή. 

Αξίζει να διευκρινιστεί ότι οι περιορισμοί θέσης που τοποθετήθηκαν έγιναν μόνο για 

τη δημιουργία της συνδεσμολογίας και δεν είναι περιορισμοί που αφορούν την κίνηση του 

μοντέλου κατά τη διάρκεια των βημάτων ανάλυσης. 

Abaqus Documentation [6] 

4.4.5 Η δημιουργία των βημάτων ανάλυσης 

Στη συνέχεια ακολούθησε η εντολή Step (βήμα) η οποία αφορά την ανάλυση που θα 

πραγματοποιηθεί στο μοντέλο. Πιο συγκεκριμένα, η εντολή step είναι η ακολουθία των 

βημάτων ανάλυσης που θα δημιουργηθούν και προσφέρει τη δυνατότητα να εξειδικευτούν 

output requests (αιτήματα εξόδου). Ακόμα, η εντολή step προσφέρει έναν ιδανικό τρόπο 

να ελεγχθούν και να πραγματοποιηθούν αλλαγές στα φορτία, στις συνοριακές συνθήκες, 
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στις τριβές, καθώς και να προστεθούν ή να αφαιρεθούν μέρη κατά τη διάρκεια της 

ανάλυσης. Επιπλέον, η εντολή  step επιτρέπει να αλλάξει το είδος της ανάλυσης σε όποιο 

σημείο είναι αναγκαίο. 

 

Τα βήματα ανάλυσης είναι τα εξής: 

1
ον

) Το Abaqus από μόνο του δημιουργεί ένα ειδικό αρχικό βήμα initial step το οποίο δεν 

επιδέχεται καμία αλλαγή ή επεξεργασία και διαγραφή. Το αρχικό αυτό βήμα επιτρέπει να 

ορισθούν συνοριακές συνθήκες και τριβές, οι οποίες επιβάλλονται με το που αρχίζει η 

ανάλυση. 

2
ον

) Τα βήματα ανάλυσης που ορίζει ο χρήστης του προγράμματος και εξυπηρετούν τη 

δουλειά που θέλει να κάνει. Το είδος των βημάτων ανάλυσης ποικίλει και μπορεί να είναι 

διαδικασίας γενικού τύπου ή γραμμικής διαταραχής. Τα βήματα γενικού τύπου περιλαμ-

βάνουν στατική ανάλυση, δυναμική ανάλυση, βισκοελαστική ανάλυση, γεωστατική ανά-

λυση, κ.ά. Τα βήματα τύπου γραμμικής διαταραχής περιλαμβάνουν λυγισμό, συχνότητα, 

στατική γραμμική διαταραχή κ.ά. 

Στο μοντέλο που προσομοιώθηκε χρησιμοποιήθηκαν βήματα  διαδικασίας γενικού 

τύπου και πιο συγκεκριμένα απεριόριστης δυναμικής ανάλυσης (Dynamic, Implicit). 

Χρησιμοποιήθηκε η εντολή Step=>Create η οποία προσφέρει τη δυνατότητα δημιουργίας 

ενός βήματος μετά από όποιο βήμα είναι επιθυμητό από το χρήστη. 

 

 

 

 

  

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.5.1: Η εντολή Step=>Create. 
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Εικόνα 4.4.5.2: Αριστερά το εικονίδιο της εντολής step και δεξιά φαίνονται τα βήματα ανάλυσης, 

τα είδη που μπορούν να επιλεχθούν και η δυνατότητα ένα βήμα ανάλυσης να εισαχθεί στο σημείο 

που επιθυμεί ο χρήστης. 
 

Για την ακρίβεια μαζί με το ειδικό αρχικό βήμα (initial step) υπήρξαν συνολικά 3 

βήματα ανάλυσης: 

1
ον

) αρχικό βήμα (initial step) 

2
ον

) βήμα που επιβάλλεται η βαρύτητα (apply gravity). 

Στο βήμα αυτό, το πρόγραμμα ουσιαστικά τρέχει τα ίδια βάρη των μερών. Το Abaqus  δεν 

τοποθετεί φορτία στο αρχικό βήμα και έτσι η βαρύτητα έπρεπε να ασκηθεί σε ένα από τα 

μετέπειτα βήματα. Για να υπάρχει καλύτερος διαχωρισμός των βημάτων και για λόγους 

καλύτερης επόπτευσης της ανάλυσης δημιουργήθηκε αυτό το βήμα, το οποίο επιλέχθηκε 

να είναι  δυναμικής ανάλυσης και όχι στατικής για λόγους καθαρά λειτουργικούς, εφόσον 

ακολουθούσε μετά από αυτό, το βήμα που ασκήθηκε η επιτάχυνση. Η διάρκεια αυτού του 

βήματος είναι 1 δευτερόλεπτο. 
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Επίσης επιλέχθηκε incrementation automatic (αυτόματη προσαύξηση) και 

increment size (μέγεθος προσαύξησης) 1. To μέγεθος προσαύξησης είναι πολύ σημαντικό 

για την ανάλυση, καθώς ουσιαστικά είναι το βήμα ανάλυσης. Για παράδειγμα στο step 

Apply Gravity ορίστηκε μέγεθος προσαύξησης 1 που σημαίνει ότι ο χρόνος θα πάει 

κατευθείαν από το 0 στο 1 sec. Η χρησιμότητα του  μεγέθους προσαυξήσεως  φαίνεται πιο 

ξεκάθαρα στο επόμενο βήμα που τοποθετείται η επιτάχυνση. 

 

 
Εικόνα 4.4.5.3: Στα αριστερά φαίνεται η διάρκεια 1  sec του βήματος Apply Gravity και η μη-

χρησιμοποίηση της επιλογής Nlgeom και στα δεξιά ο τύπος της προσαυξήσεως ο οποίος ήταν 

αυτόματος καθώς και το μέγεθος προσαύξησης που ήταν 1.  
 

3
ον

) βήμα που επιβάλλεται η επιτάχυνση (apply acceleration). 

Στο βήμα αυτό ασκείται η επιτάχυνση στο κέντρο βάρους του θεμελίου και ουσιαστικά 

πρόκειται για την έναρξη του σεισμού. Είναι βήμα δυναμικής ανάλυσης και η διάρκεια του 

είναι 2 δευτερόλεπτα. Το μέγεθος προσαύξησης τοποθετήθηκε 0.01 sec, καθώς τόσο είναι 

το βήμα του χρόνου που χρησιμοποιήθηκε για τον υπολογισμό της επιτάχυνσης. Για 

παράδειγμα, εάν εδώ είχε δοθεί μέγεθος προσαύξησης 2 τότε το πρόγραμμα θα «διάβαζε» 

τις τιμές της επιτάχυνσης μόνο στις χρονικές στιγμές 0 και 2 sec και θα εμφάνιζε την 

επιτάχυνση σαν γραμμική συνάρτηση του χρόνου. Επειδή η διάρκεια είναι 2 sec και το 

increment size είναι 0.01, τοποθετήθηκε ο μέγιστος αριθμός προσαυξήσεων να είναι 200 

καθώς για λιγότερο από 200 δε  θα «έτρεχε» το πρόγραμμα. 
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Εικόνα 4.4.5.4: Στα αριστερά φαίνεται η διάρκεια του βήματος Apply Acceleration που ήταν 2sec 

και στα δεξιά ο τύπος προσαυξήσεως που ήταν fixed (τοποθετημένο από το χρήστη), το μέγεθος 

της προσαυξήσεως που ήταν 0.01 και ο μέγιστος αριθμός των προσαυξήσεων που ήταν 200. 
 

      Αξίζει να σημειωθεί ότι η επιλογή Nlgeom δεν επιλέχθηκε για κανένα βήμα ανάλυσης. 

Η επιλογή αυτή λαμβάνει υπόψη της τη γεωμετρική μη γραμμικότητα κατά τη διάρκεια 

των βημάτων ανάλυσης. Στην παρούσα εργασία δε χρησιμοποιήθηκε καθώς για τον τύπο 

του προγράμματος αυτού (Abaqus STANDARD) δε συστήνεται. 

 

Η δημιουργία αιτημάτων εξόδου 

 

Μετά τη δημιουργία των βημάτων ακολουθεί η δημιουργία των αιτημάτων εξόδου 

(output requests). Τα αιτήματα εξόδου περιέχουν πληροφορίες για μεταβλητές που έχουν 

επιλεγεί σε κάθε προσαύξηση στα βήματα. Υπάρχουν δύο κατηγορίες αιτημάτων εξόδου: 

1
ον

) field output requests 

2
ον

) history output requests 

Η διαφορά τους είναι ότι τα field output requests είναι αιτήματα εξόδου από δεδομένα 

που είναι χωρικά κατανεμημένα σε ολόκληρο το μοντέλο ή πάνω σε ένα τμήμα του, ενώ 

τα history output requests  είναι αιτήματα εξόδου από δεδομένα σε συγκεκριμένα σημεία 

σε ένα μοντέλο. Επιλέχθηκε field output request και χρησιμοποιήθηκε η εντολή 

Output=>Field Output Requests=>Create. 
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Εικόνα 4.4.5.5: Η εντολή Output=>Field Output Requests=>Create 

 

Αξίζει να σημειωθεί ότι μπορούν να οριστούν διαφορετικά αιτήματα εξόδου για κάθε 

βήμα ανάλυσης. Στην παρούσα εργασία χρησιμοποιήθηκε ένα αίτημα εξόδου κοινό για 

όλα τα βήματα μετά το αρχικό βήμα. 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.5.6: Στα αριστερά το εικονίδιο της εντολής Output=>Field Output 

Requests=>Create και στα δεξιά η δημιουργία του αιτήματος εξόδου με τις πληροφορίες που 

απαιτούνται όπως το όνομα του αιτήματος εξόδου, το βήμα για το οποίο θα αρχίσει να ισχύει και η 

διαδικασία του βήματος. 

 

Έπειτα, επιλέγονται τα κατάλληλα μεγέθη για τα οποία απαιτούνται πληροφορίες κατά 

τη διάρκεια της ανάλυσης. Επιλέγονται μεγέθη όπως εντάσεις, μετατοπίσεις, περιστροφές, 

ταχύτητες, επιταχύνσεις, δυνάμεις, αντιδράσεις και  επαφές  τα οποία αντιστοιχούν σε 

κάποιες συγκεκριμένες μεταβλητές το καθένα. Για παράδειγμα, η μετατόπιση αντιστοιχεί 

στη μεταβλητή U και η περιστροφή στη μεταβλητή UR. 

Επιλέχθηκε η επιλογή preselected defaults (προεπιλεγμένες επιλογές), γιατί τα ίδια 

μεγέθη αν επιλέγονταν μεμονωμένα από τη λίστα θα εμφάνιζαν περισσότερες μεταβλητές, 

οι οποίες δεν ήταν διαθέσιμες για την ανάλυση που πραγματοποιείται. Συνεπώς με την 

επιλογή αυτή εμφανίζονται οι διαθέσιμες μεταβλητές που  απαιτούνται. 
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Εικόνα 4.4.5.7: Φαίνεται η επιλογή των μεγεθών που επιζητούνται πληροφορίες.  

 

Οι μεταβλητές για τις οποίες παρήχθησαν πληροφορίες ήταν οι εξής: 

Α: Χωρική επιτάχυνση στους κόμβους 

AR: Περιστροφική επιτάχυνση στους κόμβους 

CF: Συγκεντρωμένα φορτία στους κόμβους 

CM: Συγκεντρωμένες ροπές στους κόμβους 

RF: Δύναμη αντίδρασης στους κόμβους 
RM: Ροπή αντίδρασης στους κόμβους 

U:  Χωρική μετακίνηση στους κόμβους  

UR: Περιστροφική μετακίνηση στους κόμβους 

V: Χωρική ταχύτητα στους κόμβους 

VR: Περιστροφική ταχύτητα στους κόμβους 
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Εικόνα 4.4.5.8: Παρουσιάζονται οι μεταβλητές για τις οποίες δημιουργήθηκε το αίτημα εξόδου. 

 

Πρέπει να διευκρινιστεί ότι για τις μεταβλητές που αντιστοιχούν  σε ταχύτητες και 

επιταχύνσεις  παρήχθησαν πληροφορίες από το βήμα Apply Acceleration και μετά, καθώς 

είναι μεταβλητές που αντιστοιχούν σε μεγέθη δυναμικής ανάλυσης (επιτάχυνση, 

ταχύτητα). 

 

 
 

Εικόνα 4.4.5.9: Η διαχείριση του αιτήματος εξόδου στην πορεία των βημάτων ανάλυσης. 
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4.4.6 Ο προσδιορισμός των αλληλεπιδράσεων 

Όταν ολοκληρώθηκαν οι εντολές που αφορούσαν τα βήματα ανάλυσης, η διαδικασία 

συνεχίστηκε με τις εντολές που αφορούσαν τις αλληλεπιδράσεις (interactions) των 

σωμάτων ή περιοχών των σωμάτων. Οι αλληλεπιδράσεις προσδιορίζουν πώς 

συμπεριφέρονται τα σώματα ή περιοχές των σωμάτων με τα υπόλοιπα σώματα και το 

περιβάλλον γύρω τους. Περιλαμβάνουν επαφές, κινηματικές σχέσεις που σχετίζονται με 

τις μηχανικές συνδέσεις και θερμικούς περιορισμούς, όπως συναγωγές και συνοριακές 

συνθήκες ακτινοβολίας. 

Χρησιμοποιώντας την εντολή Interaction=>Create (αλληλεπίδραση=>δημιουργία) 

εμφανίζονται πολλών τύπων επιλογές για τις αλληλεπιδράσεις και δίνεται η δυνατότητα να 

τοποθετηθούν στο βήμα ανάλυσης, που επιθυμείται.  

 
Εικόνα 4.4.6.1: Στα αριστερά η εντολή Interaction=>Create και στα δεξιά τα διάφορα είδη 

αλληλεπίδρασης που μπορούν να εφαρμοστούν στο επιθυμητό βήμα ανάλυσης. 

 

Στην παρούσα εργασία ο τύπος αλληλεπίδρασης που υπάρχει είναι η αλληλεπίδραση 

επιφάνειας προς επιφάνεια. Οι επιφάνειες που αλληλεπιδρούν είναι οι βάσεις και οι 

κορυφές των 6 σπονδύλων, η κατώτερη οριζόντια επιφάνεια του επιστυλίου και η ανώτερη 

οριζόντια επιφάνεια του θεμελίου. 
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Εικόνα 4.4.6.2: Με κόκκινο χρώμα φαίνονται οι επιφάνειες που αλληλεπιδρούν. 

 

Όπως προαναφέρθηκε, στο μοντέλο που μελετήθηκε όλα τα σώματα είναι διακριτά 

άκαμπτα. Επομένως, όλες οι επιφάνειες που αλληλεπιδρούν είναι επιφάνειες διακριτά 

άκαμπτων σωμάτων. Αυτό αναφέρεται, καθώς το Abaqus δεν επιτρέπει να τοποθετηθούν 

αλληλεπιδράσεις επιφάνειας προς επιφάνεια, όταν και οι δύο επιφάνειες είναι διακριτά 

άκαμπτες. Πρέπει ή και οι δύο επιφάνειες να είναι επιφάνειες παραμορφώσιμων σωμάτων 

ή η μία επιφάνεια να είναι επιφάνεια διακριτά άκαμπτου σώματος και η άλλη 

παραμορφώσιμου σώματος για να τοποθετηθούν τέτοιου είδους αλληλεπιδράσεις. Αυτό το 

πρόβλημα οδήγησε στο να βρεθεί άλλος τρόπος για να εκφραστούν αυτές οι 

αλληλεπιδράσεις και κυρίως οι τριβές μεταξύ των ανωτέρω επιφανειών. 

Έτσι αποφασίστηκε να τοποθετηθούν connectors (σύνδεσμοι)  που θα προσομοίαζαν 

την επαφή και την τριβή και θα δίνονταν τιμές για τη δυσκαμψία. Πριν συμβεί όμως αυτό, 

έπρεπε να γίνουν κάποιες άλλες ενέργειες όπως είναι η δημιουργία wires (καλωδίων) γιατί 

οι σύνδεσμοι έπρεπε να αντιστοιχηθούν στα καλώδια αυτά.  

Χρησιμοποιήθηκε η εντολή Connector=>Geometry=>Create Wire Feature και 

τοποθετήθηκαν wires μεταξύ των reference points των μερών που είχαν επαφή. 

 

 

 

 

 

 
 

 

 

 
Εικόνα 4.4.6.3: Η εντολή Connector=>Geometry=>Create Wire Feature. 
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Στο παράθυρο που άνοιξε μετά από την εφαρμογή της εντολής Connector=> Geometry 

=>Create Wire Feature επιλέχθηκαν disjoint wires (κομματιασμένα καλώδια). Η εντολή 

αυτή χρησιμοποιήθηκε τόσες φορές, όσες ήταν και τα καλώδια που χρησιμοποιήθηκαν. 

Παρόλο που δινόταν η δυνατότητα να δημιουργηθούν όλα τα καλώδια μαζί σαν μέρη ενός, 

επιλέχθηκε να δημιουργηθούν ξεχωριστά. Αυτό έγινε, γιατί μπορεί να μην 

χρησιμοποιούνταν ο ίδιος τύπος για όλα τα καλώδια ανάλογα με το ποια μέρη ένωναν και 

με ποιο τρόπο. 

Αξίζει να αναφερθεί ότι τα  καλώδια τοποθετήθηκαν από σημείο αναφοράς σε σημείο 

αναφοράς, για να προσομοιώσουν την τριβή και τη δυσκαμψία μεταξύ δύο επιφανειών 

επαφής, καθώς τα σημεία αναφοράς είναι αντιπροσωπευτικά της κίνησης των διακριτά 

άκαμπτων σωμάτων. Ακόμη, σαν πρώτα σημεία των καλωδίων, μεταξύ δύο σωμάτων, 

επιλέχθηκαν τα σημεία αναφοράς των σωμάτων που βρίσκονταν από κάτω. Αυτό συνέβη, 

γιατί ενδεχόμενη κίνηση των χαμηλότερων σωμάτων θα επηρέαζε και τα σώματα που 

βρίσκονταν υψηλότερα από αυτά.  

 

 

Εικόνα 4.4.6.4: Το εικονίδιο της εντολής Connector=>Geometry=>Create Wire Feature και η 

επιλογή να χρησιμοποιηθούν disjoint wires (κομματιασμένα καλώδια) 
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Εικόνα 4.4.6.5: Απεικονίζονται όλα τα καλώδια που τοποθετήθηκαν στο μοντέλο. 
 

Αμέσως μετά την τοποθέτηση των wires ακολούθησε η δημιουργία connector 

sections (τμήμα συνδέσμων). Χρησιμοποιήθηκε η εντολή Connector=>Section=>Create 

(σύνδεσμος=>τμήμα=>δημιουργία). 

  

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.6.6: Η εντολή Connector=>Section=>Create. 

 

Οι κατηγορίες συνδέσμων που παρέχει το Abaqus είναι οι εξής: 

α) basic: περιλαμβάνουν μετακινησιακούς και περιστροφικούς τύπους. Οι μετακινησιακοί 

επηρεάζουν μετακινησιακούς βαθμούς ελευθερίας και στα δύο ακραία σημεία των wires 

στα οποία ο τύπος συνδέσμου έχει οριστεί και μπορεί να επηρεάσουν περιστροφικούς 

βαθμούς ελευθερίας στο πρώτο ακραίο σημείο των wires. Οι περιστροφικοί τύποι 

επηρεάζουν περιστροφικούς βαθμούς ελευθερίας στα 2 ακραία σημεία των καλωδίων. 
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β) assembled/complex: είναι προκαθορισμένοι συνδυασμοί βασικών τύπων σύνδεσης. 

Δηλαδή ένας τύπος συνδέσμου αυτής της κατηγορίας θα περιέχει και μετακινησιακούς και 

περιστροφικούς τύπους. 

γ) MPC: χρησιμοποιούνται για να ορίσουν περιορισμούς πολλών σημείων μεταξύ 2 

σημείων. 

 

Κάθε connector section οποιασδήποτε κατηγορίας στο Abaqus διαθέτει κάποια 

διαθέσιμα  και κάποια περιορισμένα CORM. CORM είναι συντομογραφία για τη 

συνιστώσα της σχετικής κίνησης (σχετικής μετακίνησης και περιστροφής) τοπικής σε ένα 

σύνδεσμο. Διαθέσιμες συνιστώσες της σχετικής κίνησης είναι οι σχετικές μετακινήσεις και 

περιστροφές, που δεν είναι κινηματικά περιορισμένες και παραμένουν διαθέσιμες για 

ενέργειες, όπως προσδιορισμό κίνησης εξαρτώμενης από το χρόνο, εφαρμογή φορτίου, 

ορισμό αλληλεπιδράσεων, όπως είναι η τριβή. Ανάλογα με την κατηγορία και τον τύπο 

σύνδεσης που επιλέγεται κάποιες συνιστώσες κίνησης είναι διαθέσιμες και κάποιες άλλες 

περιορισμένες.  

 

Δυσκαμψία 

 

Για να οριστεί δυσκαμψία  επιλέχθηκε connector section κατηγορίας basic 

translational και τύπου Cartesian. Δόθηκαν τιμές και για τις 3 διευθύνσεις της τάξης των 

10000 ΚN*m. Επιλέχθηκε τύπος Cartesian, γιατί αυτός ο τύπος παρείχε τη δυνατότητα 

σύνδεσης 2 κόμβων επιτρέποντας ανεξάρτητη συμπεριφορά στις 3 καρτεσιανές 

διευθύνσεις, που ορίζονταν απ’ το σύστημα συντεταγμένων στον κόμβο α. 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Εικόνα 4.4.6.7: Το εικονίδιο της εντολής Connector=>Section=>Create και η επιλογή 

κατηγορίας Basic και τύπου Cartesian. Επίσης φαίνονται οι διαθέσιμες και οι περιορισμένες 

συνιστώσες σχετικής κίνησης. 

 

 

 

 

 

 

 



52 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.6.8: Το διάγραμμα για τον τύπο σύνδεσης Cartesian δύο κόμβων. 

 

Ουσιαστικά, αυτός ο τύπος επιλέχθηκε γιατί δεν περιορίζει καμία συνιστώσα σχετικής 

κίνησης. Δηλαδή με τον ορισμό των δυσκαμψιών για τις 3 συνιστώσες της μετακίνησης  

είναι σαν να τοποθετήθηκαν ελατήρια με δυσκαμψία τα οποία θα προσομοίαζαν τη 

δυσκαμψία του υλικού. Επιλέχθηκε για τον τύπο Cartesian ελαστική γραμμική 

συμπεριφορά uncoupled (χωρίς συνδυασμό) και δόθηκαν τιμές για τις δυσκαμψίες των 

δυνάμεων F1, F2, F3 της τάξεως του 10^5. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 
 

Εικόνα 4.4.6.9: Η επιλογή της ελαστικότητας για τον τύπο Cartesian, έτσι ώστε να ορισθούν 

δυσκαμψίες για τις 3 διευθύνσεις της μετακίνησης. 
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Έπειτα ακολούθησε η αντιστοίχιση των συνδέσμων στα καλώδια. Αυτό επετεύχθη με 

την εντολή Connector=>Assignment=>Create.  

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.6.10: Η εντολή Connector=>Assignment=>Create. 

  

Επειδή ορίστηκε τύπος cartesian για όλο το μοντέλο, επιλέχθηκαν όλα τα καλώδια και 

επιλέχθηκε ο τύπος cartesian. Ακόμα, ορίστηκε ο προσανατολισμός των συνδέσμων με 

βάση ένα προκαθορισμένο σύστημα συντεταγμένων που είχε οριστεί προηγουμένως  ως 

datum. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.4.6.11: Στα αριστερά η επιλογή τύπου cartesian για την αντιστοίχιση στα wires και στα 

δεξιά η επιλογή του συστήματος συντεταγμένων για τον προσδιορισμό του προσανατολισμού των 

συνδέσμων. 
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Εικόνα 4.4.6.12: Κάτω δεξιά φαίνεται το σύστημα συντεταγμένων που επιλέχθηκε. 

 

Παρότι ορίστηκε η δυσκαμψία για όλο το μοντέλο στις 3 διευθύνσεις, όταν 

ολοκληρωνόταν η ανάλυση με τις δεδομένες συνθήκες οι σπόνδυλοι εμφάνιζαν μεγάλες 

ολισθήσεις μεταξύ τους μεγαλύτερες του αναμενόμενου, οι οποίες οδηγούσαν το μοντέλο 

σε κατάρρευση. Έτσι αποφασίστηκε να δημιουργηθούν εκείνες οι συνθήκες, που θα 

έκαναν τους σπονδύλους περισσότερο δύσκαμπτους και θα περιόριζαν τις ολισθήσεις 

μεταξύ τους. Τοποθετήθηκαν τέσσερα  καινούρια καλώδια που ένωναν τα σημεία 

αναφοράς των σπονδύλων και επιλέχθηκε connector section κατηγορίας assembled  και 

τύπου cylindrical. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   
 

 

 

 

 

 
Εικόνα 4.4.6.13: Απεικονίζονται τα τέσσερα καινούρια καλώδια που τοποθετήθηκαν. 
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Ο συγκεκριμένος τύπος συνδέσμου περιορίζει τις συνιστώσες σχετικής κίνησης U2, U3, 

UR2, UR3 όπως φαίνονται στο διάγραμμα του τύπου και αφήνει ελεύθερες τη U1, 

UR1.Στο μοντέλο μας δηλαδή, περιορίζει τις U1,U2,UR1,UR2 και αφήνει ελεύθερες τις 

U3,UR3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.6.14: Η επιλογή connector section κατηγορίας assembled και τύπου cylindrical. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Εικόνα 4.4.6.15: Το διάγραμμα για το σύνδεσμο τύπου cylindrical. 

 

Δημιουργήθηκαν για το συγκεκριμένο σύνδεσμο οι συνθήκες τριβής οι οποίες ήταν 

προκαθορισμένες από το Abaqus σύμφωνα με το νόμο του Coulomb και τοποθετήθηκε 

συντελεστής τριβής 0.7. 

 



56 

 

 

4.4.6.16: Η δημιουργία των συνθηκών τριβής και η τοποθέτηση του συντελεστή τριβής 0.7 

 

Στη συνέχεια αντιστοιχήθηκαν τα 4 καινούρια καλώδια στον τύπο cylindrical και 

ολοκληρώθηκε η διαδικασία των αλληλεπιδράσεων.  

Ουσιαστικά, η δημιουργία των συνδέσμων cylindrical και Cartesian πραγμαντοποιή-

θηκε γιατί δεν υπήρχε άλλος τρόπος να οριστεί η δυσκαμψία και η τριβή στο μοντέλο, 

λόγω του περιορισμού ότι είχαμε παντού άκαμπτα σώματα. Οι δύο αυτοί σύνδεσμοι  
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ισοδυναμούν με την ύπαρξη ελατηρίων αντίστοιχης δυσκαμψίας και προσομοιώνουν την 

τριβή και τη δυσκαμψία. 

Abaqus Documentation [6] 

 

4.4.7 Η επιβολή των φορτίων 

 
Μετά και τον καθορισμό των αλληλεπιδράσεων σειρά είχε η τοποθέτηση των φορτίων. 

Στην εντολή Load (φορτίο) περιέχονται δυνάμεις, ροπές, συγκεντρωμένες ή διανεμημένες 

έλξεις, ροές και γενικά επιρροές που προκαλούν παραμόρφωση, μετατόπιση, περιστροφή 

ή αλλάζουν την κατάσταση του μοντέλου από την κατάσταση χωρίς φορτία.  

Στο συγκεκριμένο μοντέλο που μελετήθηκε  δεν υπήρχαν καθόλου συγκεντρωμένες ή 

διανεμημένες δυνάμεις ή ροπές ή γενικά κάποιο μέγεθος που να επηρέαζε την κατάσταση 

του μοντέλου. Τα μόνα φορτία που υπήρχαν  ήταν τα ίδια βάρη των μερών, τα οποία 

ασκούνταν στο βήμα Apply Gravity. Χρησιμοποιήθηκε η εντολή  Load=>Create 

(φορτίο=>δημιουργία) για τη δημιουργία των ιδίων βαρών των μερών και επιλέχθηκε η 

εντολή Body Force (δύναμη σώματος) , που για διακριτά άκαμπτα μέρη εκφράζει το ίδιο 

βάρος του μέρους. Επιλέχθηκε για κάθε δύναμη σώματος όλη η γεωμετρία του κάθε 

μέρους και δόθηκε η αντίστοιχη τιμή που εξέφραζε το ίδιο βάρος του. Πρέπει να 

σημειωθεί ότι οι τιμές των ιδίων βαρών τοποθετήθηκαν σε kN. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.7.1: Το εικονίδιο της εντολής Load=>Create και η επιλογή της εντολής Body Force 

στο βήμα Apply Gravity για τον πρώτο σπόνδυλο. 

 

Η τιμή της δύναμης Body Force τοποθετήθηκε στη διεύθυνση 3 (άξονας z) με αρνητικό 

πρόσημο αφού η θετική σύμβαση έχει φορά προς τα πάνω. Επίσης επιλέχθηκε ομοιόμορφη 

διανομή. 
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Εικόνα 4.4.7.2: Η τοποθέτηση της τιμής της δύναμης σώματος για τον πρώτο σπόνδυλο. 

Πίνακας 4.4.7.3: Απεικονίζονται οι μάζες, οι βαρύτητες και οι δυνάμεις που αντιστοιχούν στο ίδιο 

βάρος για όλα τα μέρη του μοντέλου. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
1

ος
 

Σπόνδυλος 

2
ος

 

Σπόνδυλος 

3
ος

 

Σπόνδυλος Θεμέλιο Επιστύλιο 

MASS(kg) 5324 4672,25 4064,5 24750 5197,5 

GRAVITY(m/s^2) 9,81 9,81 9,81 9,81 9,81 

BODY FORCE(kN) 52.2284 45.8348 39.8727 242.798 50.9875 
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Εικόνα 4.4.7.4: Απεικονίζονται τα ίδια βάρη όλων των μερών του μοντέλου. 

 

Η δημιουργία των συνοριακών συνθηκών (boundary conditions) 

 
Αμέσως μετά την τοποθέτηση των φορτίων ακολούθησε η τοποθέτηση των 

συνοριακών συνθηκών του προβλήματος. Αρχικά, αξίζει να σημειωθεί ότι οι συνοριακές 

συνθήκες βρίσκονται και αυτές στις εντολές των φορτίων και χρησιμεύουν στο να δοθούν 

συγκεκριμένες τιμές σε βασικές μεταβλητές του προβλήματος , όπως η μετατόπιση, η 

περιστροφή κ.α. Επιλέχθηκε η εντολή BC=>Create (συνοριακή συνθήκη=>δημιουργία) 

για τη δημιουργία των συνοριακών συνθηκών και στο παράθυρο επιλογών επιλέχθηκε το 

βήμα στο οποίο χρειαζόταν να εφαρμοστούν, καθώς και το είδος που χρειαζόταν.  

Επιλέχθηκαν 2 συνοριακές συνθήκες σε όλο το μοντέλο οι οποίες ήταν και οι δύο του 

ίδιου είδους, μετατόπισης-περιστροφής (displacement/rotation). 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.7.5: Η εντολή BC=>Create. 
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Εικόνα 4.4.7.6: Στα αριστερά φαίνεται το εικονίδιο της εντολής Create Boundary Condition και 

στα δεξιά η επιλογή του είδους της συνοριακής συνθήκης στο βήμα ανάλυσης που απαιτείται. 

 

Οι συνοριακές συνθήκες που τοποθετήθηκαν ήταν οι εξής: 

1
ον

) πάκτωση στο κέντρο βάρους του θεμελίου στο αρχικό βήμα της ανάλυσης (initial 

step). Η πάκτωση εφαρμόστηκε στο κέντρο βάρους του θεμελίου (σημείο αναφοράς) και  

όχι στη βάση του, όπως λογικά θα γινόταν, καθώς το θεμέλιο όπως και όλα τα υπόλοιπα 

μέρη του μοντέλου είναι άκαμπτο και εκφράζεται στο Abaqus από την κίνηση του σημείου 

αναφοράς του. Με την πάκτωση περιορίστηκαν οι μετατοπίσεις και οι περιστροφές στους 

3 άξονες δηλαδή U1=U2=U3=UR1=UR2=UR3=0. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.4.7.7: Απεικονίζονται οι βαθμοί ελευθερίας που περιορίστηκαν με τη δημιουργία της 

συνοριακής συνθήκης της πάκτωσης. 
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Στο επόμενο βήμα, όμως, που ήταν το βήμα της επιτάχυνσης, ελευθερώθηκε η 

διεύθυνση στην οποία ασκείται η επιτάχυνση και έτσι άλλαξε η συνοριακή συνθήκη της 

πάκτωσης. Αυτό έγινε, γιατί σε αντίθετη περίπτωση δε θα είχε αποτέλεσμα η επιβολή της 

επιτάχυνσης και δε θα μπορούσε να ελεγχθεί η σεισμική απόκριση του μοντέλου.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.7.8: Η τροποποίηση της συνοριακής συνθήκης της πάκτωσης στο βήμα Apply 

Acceleration με την ελευθέρωση της διεύθυνσης στην οποία ασκείται η επιτάχυνση. 

 

2
ον

) η επιτάχυνση. Εφαρμόστηκε στο βήμα Apply Acceleration και αφορούσε μία αρχική 

τιμή επιτάχυνσης που δινόταν στην αρχή του εν λόγω βήματος. Ασκήθηκε και αυτή στο 

σημείο αναφοράς του θεμελίου.  

Δόθηκε μία συνάρτηση η οποία ρύθμιζε το πλάτος (amplitude) των τιμών της κατά τη 

διάρκεια του σεισμού. Χρησιμοποιήθηκε η εντολή Tools=>Amplitude=>Create και από 

το παράθυρο που άνοιξε επιλέχθηκε να δοθούν οι τιμές  με τη μορφή tabular (πίνακας). 
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Εικόνα 4.4.7.9: Στα αριστερά η εντολή Tools=>Amplitude=>Create και στα δεξιά οι διάφορες 

επιλογές για το πλάτος της επιτάχυνσης. 

Όπως αναφέρθηκε και στο κεφάλαιο 3, δόθηκαν 3 διαφορετικά πλάτη για την επιτά-

χυνση με διαφορετικές τιμές για κάποιους όρους της χρησιμοποιούμενης συνάρτησης: 

α) p g =0.5g=4.905 m/s 2 , β=0.5, t =0.050sec, t=0.01sec. 

β) p g =0.5g=4.905 m/s 2 , β=0.5, t =0.025sec, t=0.01sec. 

γ) p g =0.3g=2.943 m/s 2 , β=0.5, t =0.050sec, t=0.01sec 

 

Οι τιμές της επιτάχυνσης σε συνάρτηση με το χρόνο μεταφέρθηκαν στο Abaqus από το 

Microsoft Εxcel με απλή αντιγραφή των κελιών για το χρόνο και για την επιτάχυνση. 

Η γραφική παράσταση που απεικονίζει την επιτάχυνση σε σχέση με το χρόνο 

δημιουργήθηκε  στο Abaqus μέσω της εντολής Plug-ins=>Tools=>Amplitude plotter. 
 

 

Εικόνα 4.4.7.10: Η εντολή Plug-ins=>Tools=>Amplitude Plotter στα αριστερά και το παράθυρο 

που επιλέχθηκε το amplitude της επιτάχυνσης. 
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Εικόνα 4.4.7.11: Η επιτάχυνση σε σχέση με το χρόνο στο Abaqus για την περίπτωση α). Στον 

κατακόρυφο άξονα είναι οι τιμές της επιτάχυνσης και στον οριζόντιο άξονα είναι οι τιμές του 

χρόνου. 

 

 

Εικόνα 4.4.7.12: Η επιτάχυνση σε σχέση με το χρόνο στο Abaqus για την περίπτωση β). Στον 

κατακόρυφο άξονα είναι οι τιμές της επιτάχυνσης και στον οριζόντιο άξονα είναι οι τιμές του 

χρόνου. Σε σχέση με την εικόνα α) φαίνεται η διαφορά στη συχνότητα. 
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Εικόνα 4.4.7.13: Η επιτάχυνση σε σχέση με το χρόνο στο Abaqus για την περίπτωση γ). Στον 

κατακόρυφο άξονα είναι οι τιμές της επιτάχυνσης και στον οριζόντιο άξονα είναι οι τιμές του 

χρόνου. Σε σχέση με τις 2 προηγούμενες περιπτώσεις φαίνεται η διαφορά στο μέγιστο πλάτος. 

 

Στη συνέχεια επιλέχθηκε η εντολή BC=>Create για να δημιουργηθεί η συνοριακή 

συνθήκη της επιτάχυνσης στο Step Apply Acceleration και να τοποθετηθεί στο σημείο 

αναφοράς του θεμελίου. Τοποθετήθηκε η τιμή 1 ,αφού πρώτα επιλέχθηκε Amplitude-1-2-

3  για την επιτάχυνση, καθώς το Abaqus πολλαπλασιάζει τις τιμές που δίνονται στο πλάτος 

με τις τιμές που δίνονται στη συνοριακή συνθήκη. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.4.7.14: Απεικονίζεται το εικονίδιο της εντολής BC=>Create καθώς και η επιλογή της 

επιτάχυνσης ως συνοριακή συνθήκη στο βήμα Apply Acceleration. 
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Εικόνα 4.4.7.15: Απεικονίζεται η τιμή 1 που δόθηκε στην επιτάχυνση καθώς και η διεύθυνση στην 

οποία ασκήθηκε και το ότι επιλέχθηκε Amplitude-1 για την επιτάχυνση. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.4.7.16: Εδώ φαίνεται το σημείο στο οποίο ασκήθηκε η επιτάχυνση καθώς και η 

διεύθυνση της. 
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Εικόνα 4.4.7.17: Παρουσιάζονται αναλυτικά οι συνοριακές συνθήκες  κατά τη διάρκεια της 

ανάλυσης. 

 

Abaqus Documentation [6] 

4.4.8 Η διακριτοποίηση του μοντέλου με τη δημιουργία του πλέγματος 

Μόλις ολοκληρώθηκε η τοποθέτηση των φορτίων και των συνοριακών συνθηκών 

σειρά είχε η δημιουργία του πλέγματος. Το πλέγμα ουσιαστικά είναι  μια ρύθμιση των 

πεπερασμένων στοιχείων. Είναι μια δραστηριότητα διακριτοποίησης της γεωμετρίας σε 

μία πεπερασμένη αναπαράσταση στοιχείων. Όπως αναφέρθηκε και προηγουμένως, 

επιλέχθηκαν εξαρτώμενα παραδείγματα μερών που σημαίνει ότι έπρεπε η δημιουργία του 

πλέγματος να γίνει στα μέρη και όχι στην εντολή assembly. 

Για κάθε μέρος ακολουθήθηκε η ίδια διαδικασία. Πρώτα επιλέχθηκε η εντολή 

Seed=>Part (στις εντολές που αφορούν το πλέγμα), που στην ουσία είναι η “σπορά” των 

δεικτών, που τοποθετούνται κατά μήκος των άκρων των χωρίς πλέγμα μερών, για να 

υποδειχθεί η επιθυμητή πυκνότητα του πλέγματος. Με την εντολή Seed=>Part ορίζονται 

το μέσο μέγεθος στοιχείων για όλο το μέρος, ο αριθμός των στοιχείων κατά μήκος μίας 

ακμής και εάν απαιτείται έλεγχος καμπυλότητας, καθώς η γεωμετρία των μερών που 

σπέρνονται ποικίλει σε μέγεθος. Ο έλεγχος καμπυλότητας είναι αναγκαίος, ειδικά γύρω 

από μικρά καμπύλα χαρακτηριστικά, έτσι ώστε το πλέγμα που θα δημιουργηθεί να είναι 

επαρκές. Τέλος, ορίζεται και ένας παράγοντας απόκλισης, έτσι ώστε το πλέγμα 

διαφορετικών μερών όταν αυτά συνδέονται στην εντολή assembly, να είναι συνεχόμενο. 
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Εικόνα 4.4.8.1: Αριστερά φαίνεται το εικονίδιο για την εντολή Seed=>Part και δεξιά το παράθυρο 

επιλογής του μεγέθους του πλέγματος για το επιστύλιο. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.2: Αριστερά φαίνεται το επιστύλιο χωρίς πλέγμα και δεξιά φαίνεται πάλι το επιστύλιο 

μετά την εντολή Seed=>Part και την τοποθέτηση των δεικτών. 

 

Αμέσως μετά επιλέχθηκε η εντολή Mesh=>Part και ολοκληρώθηκε το πλέγμα στο 

μέρος. 
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Εικόνα 4.4.8.3: Απεικονίζεται αριστερά το εικονίδιο της εντολής Mesh=>Part και δεξιά το 

επιστύλιο με πλέγμα. 

 

Ακολουθήθηκε η ίδια διαδικασία και για τα υπόλοιπα μέρη και παρατίθενται εικόνες 

όλων χωρίς πλέγμα και  έχοντας πλέγμα καθώς και οι επιλογές για το μέσο μέγεθος των 

δεικτών όλων των parts. 

 

1
ον

) Ο πρώτος σπόνδυλος. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.4: Η εντολή Seed=>Part για τον 1ο σπόνδυλο και οι υπόλοιπες επιλογές που 

αφορούν το πλέγμα. 
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Εικόνα 4.4.8.5: Στα αριστερά ο πρώτος σπόνδυλος χωρίς πλέγμα και στα δεξιά ο πρώτος 

σπόνδυλος μετά την εφαρμογή της εντολής Seed=>Part. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.6: Ο πρώτος σπόνδυλος με πλέγμα. 
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2
ον

) Ο δεύτερος σπόνδυλος. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.7: Η εντολή Seed=>Part για τον 2ο σπόνδυλο και οι υπόλοιπες επιλογές που 

αφορούν το πλέγμα. 

Εικόνα 4.4.8.8: Στα αριστερά ο δεύτερος σπόνδυλος χωρίς πλέγμα και στα δεξιά ο δεύτερος 

σπόνδυλος μετά την εφαρμογή της εντολής Seed=>Part. 
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Εικόνα 4.4.8.9: Ο δεύτερος σπόνδυλος με πλέγμα. 

 

3
ον

) Ο τρίτος σπόνδυλος. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.10: Η εντολή Seed=>Part για τον 3ο σπόνδυλο και οι υπόλοιπες επιλογές που 

αφορούν το πλέγμα. 
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Εικόνα 4.4.8.11: Στα αριστερά ο τρίτος σπόνδυλος χωρίς πλέγμα και στα δεξιά ο τρίτος σπόνδυλος 

μετά την εφαρμογή της εντολής Seed=>Part . 

 

 

 

Εικόνα 4.4.8.12: Ο τρίτος σπόνδυλος με πλέγμα. 
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4
ον

)Το θεμέλιο. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.13: Η εντολή Seed=>Part για το θεμέλιο και οι υπόλοιπες επιλογές που αφορούν το 

πλέγμα. 

 
Εικόνα 4.4.8.14: Στα αριστερά το θεμέλιο χωρίς πλέγμα και στα δεξιά το θεμέλιο μετά την 

εφαρμογή της εντολής Seed=>Part. 
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Εικόνα 4.4.8.15: Το θεμέλιο με πλέγμα. 

 

Αμέσως μετά την ολοκλήρωση του πλέγματος για κάθε part ορίστηκε ο τύπος των 

στοιχείων του πλέγματος. Αυτό επετεύχθη χρησιμοποιώντας την εντολή Mesh=>Element 

type (πλέγμα=>τύπος στοιχείου). Πρώτα διαλέχτηκε ολόκληρη η γεωμετρία του μέρους με 

πλέγμα για όλα τα μέρη και μετά ορίστηκε ο τύπος των στοιχείων του πλέγματος να είναι 

διακριτά άκαμπτος, όπως δηλαδή και των μερών. Ακόμη, καθορίστηκε η γεωμετρική 

σειρά των στοιχείων να είναι γραμμική και να χρησιμοποιηθεί η βιβλιοθήκη στοιχείων του 

Abaqus Standard. 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 
Εικόνα 4.4.8.16: Η εντολή Mesh=>Element type. 
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Εικόνα 4.4.8.17: Απεικονίζεται η επιλογή τύπου για τα στοιχεία του πλέγματος και για τη 

γεωμετρική τους σειρά. 
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Αφού επελέγη τύπος για όλα τα στοιχεία του πλέγματος όλων των parts τότε το πλέγμα 

ολοκληρώθηκε. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.8.18: Ολόκληρο το μοντέλο στην εντολή assembly με πλέγμα. 

 

Abaqus Documentation [6] 

4.4.9 Η υποβολή της ανάλυσης για επεξεργασία 

Μετά από την ολοκλήρωση του πλέγματος ακολούθησε η υποβολή της δουλειάς για να 

πραγματοποιηθεί η ανάλυση και να παραχθούν τα αποτελέσματα. Αυτό έγινε, αφού είχαμε 

εισέλθει στη κατηγορία εντολών που αφορούσαν τη δουλειά και μέσω της εντολής 

Job=>Create (δουλειά=>δημιουργία). Εκεί ονομάστηκε η δουλειά ως seismic response. 
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Εικόνα 4.4.9.1: Στα αριστερά η εντολή Job=>Create και στα δεξιά το εικονίδιο της εντολής, 

καθώς και η ονομασία της δουλειάς. 

 

Προτού υποβληθεί η δουλειά για επεξεργασία έγινε ένας γρήγορος έλεγχος για το αν 

έχουν εισαχθεί σωστά τα δεδομένα. Aυτό πραγματοποιήθηκε με την εντολή Job=>Data 

Check=>Seismic Response (Δουλειά=>Έλεγχος Δεδομένων=>Σεισμική Απόκριση). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.4.9.2: Η εντολή Job=>Data Check=>Seismic Response 

 

Αφού όλα τα δεδομένα είχαν εισαχθεί σωστά, τότε η δουλειά μπορούσε να υποβληθεί 

για να εξαχθούν τα αποτελέσματα. Αυτό έγινε με την εντολή Job=>Submit=>Seismic 

Response (Δουλειά=>Υποβολή=>Σεισμική Απόκριση). 
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Εικόνα 4.4.9.3: Η εντολή Job=>Submit=>Seismic Response. 

 

Όταν ολοκληρώθηκε η ανάλυση, η διαδικασία συνεχίστηκε με την εμφάνιση των 

αποτελεσμάτων. Χρησιμοποιήθηκε η εντολή Job=>Results=>Seismic Response 

(Δουλειά=>Αποτελέσματα=>Σεισμική Απόκριση). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.9.4: Η εντολή Job=>Results=>Seismic Response 

 

Abaqus Documentation [6] 

4.4.10 Η προβολή των αποτελεσμάτων 

Μετά τη χρήση της εντολής αυτής  βρεθήκαμε στις εντολές Visualization. Οι 

συγκεκριμένες εντολές αφορούν την προβολή του μοντέλου σε διάφορα στάδια της 

ανάλυσης, σε διάφορες καταστάσεις και φυσικά την προβολή των αποτελεσμάτων για τις 
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μεταβλητές που επιλέχθηκαν κατά τη δημιουργία του αιτήματος εξόδου(field output 

request). 

Αρχικά το μοντέλο παρουσιάζεται χωρίς να έχει λάβει καμία παραμόρφωση και στο 

αρχικό βήμα της ανάλυσης.  

 

 
Εικόνα 4.4.10.1: Στα αριστερά το εικονίδιο για την προβολή του μοντέλου χωρίς παραμόρφωση. 

Απεικονίζεται το μοντέλο στην αρχή της ανάλυσης και πιο συγκεκριμένα στο step Apply Gravity 

την χρονική στιγμή t=0. 

 

Υπάρχουν επιλογές για την γραφική προβολή του μοντέλου μέσω των οποίων ο 

χρήστης μπορεί να δει τιμές για τις μεταβλητές που έχει επιλέξει σε κάθε βήμα ανάλυσης 

και σε κάθε time increment  για κάθε βήμα. 

Προτού όμως επιλεγεί να προβληθεί το μοντέλο σε κατάσταση παραμόρφωσης πρέπει 

να οριστεί ο συντελεστής κλίμακας, έτσι ώστε να παρουσιάζεται το μοντέλο σε 

πραγματικές συνθήκες. Αυτό επιτυγχάνεται με την εντολή Options=>Common=> 

Basic=>Deformation Scale Factor=>Uniform και τοποθετώντας την τιμή 1 για το 

συντελεστή. 

Εκτός από το συντελεστή κλίμακας στις επιλογές Common Options, Superimpose 

Options και Result Options o χρήστης μπορεί να διαμορφώσει επιλογές σχετικά με τα 

χρώματα, τις διαστάσεις, τις ετικέτες, την ακρίβεια των αποτελεσμάτων, το τι προβάλλεται 

και τα διαγράμματα των αποτελεσμάτων. 
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Εικόνα 4.4.10.2: Στα αριστερά η εντολή Options=>Common και στα δεξιά το εικονίδιο της 

εντολής και η τοποθέτηση της τιμής 1 για το συντελεστή κλίμακας. 

 

 
Εικόνα 4.4.10.3: Στα αριστερά το εικονίδιο για την προβολή του μοντέλου με παραμόρφωση. 

Απεικονίζεται το μοντέλο στο Step Apply Αcceleration τη χρονική στιγμή t=2 sec.Δηλαδή 

απεικονίζεται η τελική κατάσταση του μοντέλου όσο επιδρά σε αυτό η επιτάχυνση του σεισμού. 

 

Φαίνεται και από την παραπάνω εικόνα ότι οι δύο σπονδυλωτοί κίονες περιστρέφονται 

και οι σχετικές  μετακινήσεις μεταξύ των σπονδύλων είναι πάρα πολύ μικρές. 
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Μέσω της εντολής Animate=>Time History (Προβολή σε κίνηση=>Χρονοϊστορία) 

ήταν εφικτό να παρουσιαστεί η κατάσταση του μοντέλου σε διάφορες χρονικές στιγμές 

της ανάλυσης. 

 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.4.10.4: Στα αριστερά η εντολή Animate=>Time History και στα δεξιά το εικονίδιο 

της. 
 

 

Εικόνα 4.4.10.5: Στα αριστερά το μοντέλο τη χρονική στιγμή t=1sec και στα δεξιά τη χρονική 

στιγμή t=1.5 sec. 
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Εικόνα 4.4.10.6: Στα αριστερά το μοντέλο τη χρονική στιγμή t=2 sec και στα δεξιά τη χρονική 

στιγμή t=2.5 sec. 

 

Αφού ελέγχθηκαν οι καταστάσεις του μοντέλου για διάφορες χρονικές στιγμές της 

ανάλυσης , σειρά είχε η προβολή των αναλυτικών αποτελεσμάτων των μεταβλητών που 

είχαν επιλεγεί. Χρησιμοποιήθηκε η εντολή Tools=>XY Data=>Create για την 

παρουσίαση των αποτελεσμάτων σε διαγράμματα όπου στον X άξονα βρίσκονταν οι τιμές 

του χρόνου και στον Y άξονα οι τιμές της εκάστοτε μεταβλητής. Στο παράθυρο που 

άνοιξε, απλά επιλέχθηκε το είδος του αιτήματος εξόδου που είχε δημιουργηθεί σε 

νωρίτερο στάδιο της διαδικασίας. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Εικόνα 4.4.10.7: Στα αριστερά η εντολή Tools=>XY Data=>Create , στη μέση το εικονίδιο της 

εντολής και στα δεξιά η επιλογή του αντίστοιχου αιτήματος εξόδου που είχε επιλεγεί νωρίτερα. 
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Στη συνέχεια επιλέχθηκε μία μεταβλητή και η διεύθυνση στην οποία ήταν επιθυμητό 

να ελεγχθεί, καθώς και το σημείο του μοντέλου. Επειδή το μοντέλο αποτελείται από 

διακριτά άκαμπτα σώματα ελέγχθηκαν τα σημεία αναφοράς των σωμάτων, τα οποία ήταν 

και αντιπροσωπευτικά της κίνησης 

 

 

 
Εικόνα 4.4.10.8: Στα αριστερά φαίνεται η επιλογή της μεταβλητής της μετατόπισης για τη 

διεύθυνση του άξονα X και στα αριστερά ο τρόπος με τον οποίο επιλέχθηκε το σημείο για το οποίο 

ζητούνταν τα αποτελέσματα. 

 

Abaqus Documentation [6] 
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Κεφάλαιο 5ο - Ανάλυση του φορέα με το πρόγραμμα 

Abaqus και παρουσίαση των αποτελεσμάτων 

5.1 Εισαγωγή  

Στο κεφάλαιο αυτό παρουσιάζονται τα αποτελέσματα της δυναμικής ανάλυσης που 

πραγματοποιήθηκε με το πρόγραμμα Abaqus και γίνεται σύγκριση μεταξύ των 3 

διαφορετικών περιπτώσεων επιτάχυνσης που χρησιμοποιήθηκαν. 

5.2 Δυναμική ανάλυση 

Προκειμένου να ελέγξουμε την παραμορφωμένη γεωμετρία του φορέα τρέχουμε τις 3 

διαφορετικές δυναμικές αναλύσεις. Παρατίθενται αποτελέσματα για την μετακίνηση U1 

και για τις 3 περιπτώσεις επιτάχυνσης που δόθηκαν στο μοντέλο, παρότι η πρώτη 

περίπτωση είναι η δυσμενέστερη. 

 

5.2.1 Παραμορφωμένη γεωμετρία φορέα 

Γραφικά παρατίθενται περιγράμματα τιμών με διαφορετικά χρώματα πάνω στο 

παραμορφωμένο μοντέλο για τη χρονική στιγμή t=3 sec δηλαδή, αφού έχει ολοκληρωθεί ο 

σεισμός και η επιτάχυνση έχει μηδενιστεί. Αναλυτικά θα παρουσιαστούν διαγράμματα 

χρονοιστοριών μετακίνησης. 

 

Α)p g =0.5g=4.905 m/s 2 ,β=0.5, t =0.05sec, t=0.01sec. 

 

 

Εικόνα 5.2.1.1: Η γραφική απεικόνιση του παραμορφωμένου μοντέλου με χρησιμοποίηση 

περιγραμμάτων για τις τιμές της μετακίνησης U1. 
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Β)  p g =0.5g=4.905 m/s 2 ,β=0.5, t =0.025sec , t=0.01sec 

 

 
Εικόνα 5.2.1.2: Η γραφική απεικόνιση του παραμορφωμένου μοντέλου με χρησιμοποίηση 

περιγραμμάτων για τις τιμές της μετακίνησης U1. 

 

Γ) p g =0.3g=2.943 m/s
2

,β=0.5, t =0.05sec, t=0.01sec 

 

 

Εικόνα 5.2.1.3: Η γραφική απεικόνιση του παραμορφωμένου μοντέλου με χρησιμοποίηση 

περιγραμμάτων για τις τιμές της μετακίνησης U1. 
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5.2.2 Αναλυτική παρουσίαση αποτελεσμάτων δυναμικής ανάλυσης 

Α) p
g
=0.5g=4.905 m/s 2 ,β=0.5, t =0.05sec, t=0.01sec. 

 

Το θεμέλιο είχε μέγιστη μετακίνηση  0.15 μέτρα στο τέλος του σεισμού. 
 

 

Εικόνα 5.2.2.1: Διάγραμμα χρονοιστορίας μετακινήσεων για το θεμέλιο. 

 

Οι πρώτοι σπόνδυλοι των δύο κιόνων ακολούθησαν την κίνηση του θεμελίου εμφάνισαν 

και οι δύο μεγάλες τιμές στη μετακίνηση της τάξεως των 0.135 μέτρων. 
 

 

Εικόνα 5.2.2.2: Διάγραμμα χρονοιστορίας μετακινήσεων για τους πρώτους σπονδύλους των δύο 

κιόνων. 

 



 

87 

Οι δεύτεροι σπόνδυλοι εμφάνισαν μικρότερη μετακίνηση από τους πρώτους καθώς το 

φαινόμενο του λικνισμού ήταν πιο έντονο όσο μεγάλωνε το ύψος. Εμφάνισαν μετακίνηση 

με μέγιστη τιμή 0.09 μέτρα. 

 

 
Εικόνα 5.2.2.3: Διάγραμμα χρονοιστορίας μετακινήσεων για τους δεύτερους σπονδύλους των δύο 

κιόνων. 

 

Οι τρίτοι σπόνδυλοι εμφανίζουν σαφώς μικρότερη μετακίνηση από τους δύο 

προηγούμενους της τάξεως των 0.048 μέτρων. 

 

Εικόνα 5.2.2.4: Διάγραμμα χρονοιστορίας μετακινήσεων για τους τρίτους σπονδύλους των δύο 

κιόνων. 

 

Τέλος το επιστύλιο είναι το μοναδικό μέρος του μοντέλου το οποίο αναπτύσσει και 

μεγάλες αρνητικές τιμές κατά τη διάρκεια της εφαρμογής της επιτάχυνσης. Αυτό 

συμβαίνει, επειδή κατά τη διάρκεια του σεισμού η στροφή των κιόνων γίνεται μεγαλύτερη 

και έτσι  επηρεάζεται η κίνηση του επιστυλίου πάνω στις κορυφές των τρίτων σπονδύλων. 
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Η τελική θετική μετακίνηση είναι περίπου ίση με την μέγιστη αρνητική της τάξεως των 

0.021 μέτρων. 

 

 
Εικόνα 5.2.2.5: Διάγραμμα χρονοιστορίας μετακινήσεων για το επιστύλιο. 

 

Γ)  p g =0.5g=4.905 m/s 2 ,β=0.5, t =0.025sec , t=0.01sec 

Το θεμέλιο είχε μέγιστη μετακίνηση  0.09 μέτρα στο τέλος του σεισμού. 

 

 

Εικόνα5.2.2.6: Διάγραμμα χρονοιστορίας μετακινήσεων για το θεμέλιο. 

 

Οι πρώτοι σπόνδυλοι είχαν μετακίνηση  0.08 μέτρα. 
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Εικόνα 5.2.2.7: Διάγραμμα χρονοιστορίας μετακινήσεων για τους πρώτους σπονδύλους των δύο 

κιόνων. 

 

Οι δεύτεροι σπόνδυλοι είχαν μετακίνηση 0.055 μέτρα. 

 

 
Εικόνα 5.2.2.8: Διάγραμμα χρονοιστορίας μετακινήσεων για τους δεύτερους σπονδύλους των δύο 

κιόνων. 

 

Οι τρίτοι σπόνδυλοι είχαν μετακίνηση0.028 μέτρα. 
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Εικόνα 5.2.2.9: Διάγραμμα χρονοιστορίας μετακινήσεων για τους τρίτους σπονδύλους των δύο 

κιόνων. 

 

Το επιστύλιο είχε μετακίνηση 0.012 μέτρα. 

 

 

 
Εικόνα 5.2.2.10: Διάγραμμα χρονοιστορίας μετακινήσεων για το επιστύλιο. 
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Β) p g =0.3g=2.943 m/s
2

,β=0.5, t =0.05sec, t=0.01sec 

 

Το θεμέλιο είχε μέγιστη μετακίνηση  0.067 μέτρα στο τέλος του σεισμού. 

 

 
Εικόνα 5.2.2.11: Διάγραμμα χρονοιστορίας μετακινήσεων για το θεμέλιο. 

 

Οι πρώτοι σπόνδυλοι είχαν μετακίνηση  0.06 μέτρα. 
 

 

Εικόνα 5.2.2.12: Διάγραμμα χρονοιστορίας μετακινήσεων για τους πρώτους σπονδύλους των δύο 

κιόνων. 
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Οι δεύτεροι σπόνδυλοι είχαν μετακίνηση 0.041 μέτρα. 
 

 

Εικόνα 5.2.2.13: Διάγραμμα χρονοιστορίας μετακινήσεων για τους δεύτερους σπονδύλους των δύο 

κιόνων. 

 

Οι τρίτοι σπόνδυλοι είχαν μετακίνηση0.022 μέτρα. 

 

 
Εικόνα 5.2.2.14: Διάγραμμα χρονοιστορίας μετακινήσεων για τους τρίτους σπονδύλους των δύο 

κιόνων. 

 

Το επιστύλιο είχε μετακίνηση 0.0085 μέτρα. 
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Εικόνα 5.2.2.15: Διάγραμμα χρονοιστορίας μετακινήσεων για το επιστύλιο. 

Πίνακας 5.2.2.1: Οι μετακινήσεις U1 για τις 3 περιπτώσεις επιτάχυνσης που χρησιμοποιήθηκαν για 

όλα τα μέρη του μοντέλου. 

ΜΕΤΑΚΙΝΗΣΗ U1 (m) 

Περίπτωση ΘΕΜΕΛΙΟ 
1

ος
 

ΣΠΟΝΔΥΛΟΣ 

2
ος

 

ΣΠΟΝΔΥΛΟΣ 

3
ος

 

ΣΠΟΝΔΥΛΟΣ 
ΕΠΙΣΤΥΛΙΟ 

Α 0.15 0.135 0.091 0.048 0.02 

Β 0.067   0.06  0.041 0.022  0.0085  

Γ  0.09  0.08 0.055  0.028   0.012 
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ΚΕΦΑΛΑΙΟ 6ο – Συμπεράσματα 

Στην παρούσα διπλωματική εργασία προσομοιώσαμε δύο σπονδυλωτούς κίονες 

στηριζόμενους σε ένα θεμέλιο και συνδεόμενους με ένα επιστύλιο με τη μέθοδο των 

πεπερασμένων στοιχείων με το πρόγραμμα Abaqus.  

Χρησιμοποιήθηκαν τρεις διαφορετικές συναρτήσεις αποσβενόμενου μισού 

ημιτονοειδούς παλμού, που εξέφραζαν την επιτάχυνση με διαφορετικούς παράγοντες, 

όπως το μέγιστο πλάτος επιτάχυνσης και το χρόνο ενός κύκλου της συνάρτησης. 

Συγκρίνοντας τα αποτελέσματα της δυναμικής ανάλυσης για τις τρεις διαφορετικές 

περιπτώσεις επιτάχυνσης και λαμβάνοντας υπόψη τα γεωμετρικά χαρακτηριστικά των 

σπονδύλων, του επιστυλίου και του θεμελίου, τις φυσικές και μηχανικές ιδιότητες του 

υλικού βάσει πειραμάτων και βιβλιογραφίας, οδηγηθήκαμε στα παρακάτω συμπεράσματα 

σχετικά με τη σεισμική απόκριση των επιμέρους μερών του μοντέλου που 

προσομοιώθηκε: 

 

► Από τη βιβλιογραφία γνωρίζουμε ότι  μεταξύ δύο γεωμετρικά ομοίων άκαμπτων 

block το ψηλότερο block είναι πάντα πιο σταθερό. Στη συγκεκριμένη εργασία έχουμε δύο 

κίονες  ίδιου ύψους, όμως παρατηρούμε ότι οι σπόνδυλοι που βρίσκονται σε ψηλότερο 

ύψος και στις τρεις περιπτώσεις επιτάχυνσης, έχουν μικρότερη μετακίνηση από τους 

υπόλοιπους σπονδύλους και κατά συνέπεια είναι πιο σταθεροί. 

 

►Οι μετατοπίσεις των κιόνων και οι ολισθήσεις μεταξύ των σπονδύλων  κατά τη 

διάρκεια της σεισμικής διέγερσης αυξάνονται. Η μετατόπιση της δοκού του επιστυλίου 

παρουσιάζει το μεγαλύτερο ενδιαφέρον καθώς έχει αρνητικές τιμές μέχρι τη χρονική 

στιγμή 2.68 sec, όπου μηδενίζεται και αρχίζει να έχει θετικές τιμές. Τη χρονική στιγμή 

αυτή έχει γίνει πολύ σημαντική η επίδραση του λικνισμού των σπονδύλων και γι αυτό το 

λόγο επηρεάζεται η μετατόπιση του επιστυλίου. 

 

►Οι μετατοπίσεις των πρώτων σπονδύλων λαμβάνουν τις μεγαλύτερες τιμές, καθώς 

ακολουθούν τη μετατόπιση του θεμελίου, ενώ οι δεύτεροι και οι τρίτοι σπόνδυλοι 

λαμβάνουν μικρότερες τιμές λόγω της στροφής και του λικνισμού. 

 

►Η συνάρτηση αποσβενόμενου μισού ημιτονοειδούς παλμού που χρησιμοποιήθηκε 

για να δοθούν τιμές στην επιτάχυνση ήταν η o

t

gx ttepf /sin . 

● Συγκρίνοντας τις περιπτώσεις α) και β) παρατηρούμε ότι όταν μειώνεται ο χρόνος 

ενός κύκλου της μισής-ημιτονοειδούς συνάρτησης, όλες οι μετατοπίσεις των υπό εξέταση 

μερών του μοντέλου μειώνονται δραστικά, μικρότερες από τις μισές τιμές τους.  

Μειώνοντάς τον, η συνάρτηση της επιτάχυνσης έγινε πολύ υψηλής συχνότητας. 

Αποδεικνύεται, δηλαδή, ότι ο χρόνος t  είναι ένας κρίσιμος παράγοντας επίδρασης στη 

σεισμική απόκριση του μοντέλου. 

● Συγκρίνοντας τις περιπτώσεις α) και γ) παρατηρούμε ότι, όταν μειώνεται το μέγιστο 

πλάτος της συνάρτησης της επιτάχυνσης p g , τότε οι μετατοπίσεις των μερών μειώνονται 

σημαντικά. Πιο συγκεκριμένα παρατηρούμε  ότι μειώνονται σε τιμές σχεδόν του μισού 
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τους. Αποδεικνύεται, δηλαδή, ότι το μέγιστο πλάτος της συνάρτησης είναι ένας 

σημαντικός παράγοντας για τη σεισμική απόκριση του μοντέλου. 

● Τέλος, συγκρίνοντας τις περιπτώσεις β) και γ) που έχουν διαφορετικό μέγιστο 

πλάτος της συνάρτησης της επιτάχυνσης p
g
 και διαφορετικό χρόνο ενός κύκλου της 

μισής-ημιτονοειδούς συνάρτησης t , παρατηρούμε ότι  μικρότερες τιμές στις μετατοπίσεις 

έχει η περίπτωση β). Όπως φάνηκε και από τη σύγκριση των δύο περιπτώσεων αυτών με 

την περίπτωση α), έτσι και εδώ, αποδεικνύεται ότι ο πιο σημαντικός παράγοντας για τη 

σεισμική απόκριση του μοντέλου είναι  ο χρόνος κύκλου της συνάρτησης. 
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